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How Do I...
¨ Print on landscape paper?
SmartDraw drawings can be printed in either the portrait or landscape direction on the 
paper. To change this setting use the Printer Setup under the File Menu. 

¨ Print my big drawing on one page?
To print a drawing so that it fits on one page, check the Print on One Page check box in 
the Print Dialog. If this box is checked, SmartDraw will scale your drawing to fit on the 
page. If your drawing is really large this may cause text to be less readable.

¨ Transfer a drawing to another program?
The simplest way to insert a SmartDraw drawing into another program, like a word 
processor, is to copy and paste: Make sure no objects are selected, then use the Copy 
command (Edit Menu). This places a copy of the drawing on the clipboard. Then go to the 
word processor (or any other program) and use the Paste command. The drawing will be 
inserted into the word processors document.
You can also save a SmartDraw drawing in a number of different file formats.

¨ Save a drawing in another file format?
Use the Export command under the File Menu to save a SmartDraw drawing in another 
file format: Formats supported include GIF, BMP, JPEG, and WMF. The WMF format (Windows
Metafile) is the best choice if you want to later import the drawing into another program 
because it is a vector    format that scales properly.

¨ Transfer a drawing to a web page?
Use the Export command under the File Menu to save the drawing in either a GIF or JPEG 
format. This will create a web compatible bitmap of your drawing. Insert this GIF or JPEG 
image into your HTML page using a web-page editor. When you save to GIF, SmartDraw 
gives you the option of creating an image with a background that will appear to be 
transparent on your web page.

¨ Move things very precisely?
When one or more objects are selected, pressing the Arrow Keys on the keyboard moves 
the objects by one pixel at a time in the direction of the arrow. The Snap-to grid is ignored 
for this operation.



What's New in SmartDraw 3?
SmartDraw is the easy-to-use program that lets anyone draw great looking flowcharts, 
diagrams and other business graphics. Now with Version 3, SmartDraw adds a long list of 
new benefits that make it easier to use than ever before. 

¨ Instantly Format Charts
Create perfectly formatted organization charts, fishbone diagrams, network diagrams, 
timelines and other arrays of shapes, automatically with the new Connector objects.

¨ Create Common Diagrams with One Step
Create instant diagrams using SmartDraws new templates for common diagram types, such
as flowcharts, organization charts, time lines, fishbone charts, space planning and more. 
Each with its own special toolbar.

¨ Quickly Find the Symbol You Need
Quickly find the symbol you need using SmartDraws new symbol search feature. Search by 
name, or browse briskly through previews of each library using the symbol browser.

¨ Create Your Own Toolbar
Change a library window into a toolbar by docking it against the top of the program 
window. Add your own shapes to it.

¨ Create Your Own Shapes
Combine lines and curves into new fill-able shapes. Change the outlines of existing shapes. 
Make just the symbol you need and then add it to a library and use it over and over again.

¨ Drag and Drop Everything!
 Add new symbols to a library by simply dragging shapes from the page onto a library 
window. 
 Add shapes to the toolbar in the same way. 
 Import other graphics files by simply dragging them onto a drawing. 
 Include SmartDraw drawings in Word documents and other programs by simply dragging 
shapes from one program window to another.

¨ Rotate and Flip Shapes
Rotate shapes, SmartDrawings, text and lines by any angle. Turn them upside down and flip
them horizontally for more flexibility.

¨ Attach Text to Lines
Make your diagrams easier to understand and maintain by attaching text to lines. Move the
line and the text moves, too.

¨ Change Line Shapes With One Click
Change straight lines to arcs, arcs to multi-segment lines, and multi-segment lines back to 
straight lines, using the new line shape menu. Change connector arrangements too.

¨ Choose From Twelve More Arrowhead styles
SmartDraw now offers 24 different arrowhead styles, including arrowheads in the center of 
lines, one-to-many, many-to-one, and many more. When automatic arrowheads are chosen,
they automatically point in the direction that the line was drawn.

¨ Draw to Scale with Automatic Dimensioning. 



Set the rulers to show the scale you want. Draw lines that are automatically labeled with 
their length using this scale.

¨ Draw Perfectly Straight Connection Lines. 
Shapes now align with their centers snapped to the grid, ensuring that connecting lines are 
always perfectly straight. No more kinks!

¨ Instantly Format Text 
 Give each paragraph in a shape its own alignment.
 Format text with bullets automatically.
 Insert any symbol from any font

¨ Preview Before You Print 
Preview each page before printing using the new Print Preview command, just like Microsoft
Word and Excel.

¨ Automatically Center Drawings 
Automatically center your entire drawing on the page before you print.

¨ Attach Internet Links (and other documents) to shapes 
The SmartDraw Attach feature now lets you attach web addresses, documents from other 
programs like Microsoft Word, and program command lines to shapes, as well as other 
SmartDraw drawings.

¨ Full compatibility between 16 and 32 bit versions
The Windows 3.1 and Windows 95 versions of SmartDraw 3 share common file formats. 
Libraries and drawings can be exchanged across 16- and 32-bit versions of the program.

¨ Enjoy Many Other Improvements: 
 Hundreds of new symbols and templates
 New curved lines
 Outline-only mode for faster fit-to-page view drawing
 Much faster library drawing
 Better linking of shapes to each other
 Better grouping and ungrouping
 User-defined zoom level
 See page boundaries at all zoom levels
 Apply color and shadow styles independently
 Change the sizing behavior of any object
 Open up to 32 drawings at the same time
 Open up to 16 libraries at the same time
 Many more..



SmartDraw Tips and Tricks
Connecting shapes with perfectly straight lines
With SmartDraw, you can connect two shapes with a line that stays connected when the 
shape at either end is moved. This is described in detail elsewhere. Sometimes the line 
connecting the shapes is not perfectly straight because of the positions of the connect 
points on each shape. 

The best way to avoid this problem is to set the snap to grid feature so that the center 
of shapes snap to the grid. If the lines used to link the shapes are attached at the center 
of the sides of the shapes, the connecting lines will be perfectly straight. Note that the snap
to grid in drawings created with versions 1.0 and 2.0 is NOT set this way. Go to the Define 
Rulers and Grid command under the Edit menu to correct this.

Another way to correct this problem is by adjusting the shape positions with the arrow keys.
If you select a line or shape by clicking on it, you can adjust its position by 1 screen pixel 
up, down, left or right by typing the arrow keys on the keyboard. Use this feature to fine 
tune the position of objects without regard to the Snap-to Grid.

Keeping the toolbar buttons selected
Normally when you click on a tool in the toolbar (or a SmartDrawing Window) and you draw
a line or shape, the pointer tool (the arrow) become selected immediately afterwards. You 
can keep a tool selected, so that you can draw multiple lines or shapes pressing its button 
each time, by holding the Shift key down when you first select the tool by clicking on it.

Moving a collection of objects as a group
You can move some, or all, of the objects in your drawing without disturbing their relative 
positions by first selecting them and then by moving just one of the objects. The rest of the 
selection will also move.

You can select more than one object at a time very easily, in several different ways. You can
move a collection of objects in the same ways as a single object: Using the mouse, the 
arrow keys and the Align command.

You can also use the Group command to formally combine selected objects into a single 
object.



The Basics of Flow Charting
Flow charts are diagrams that portray the flow of information and the decision-making 
process that controls the flow. While many styles of flow charting have developed, each 
with its own set of specialized symbols, most processes can be represented using just a few
simple symbols.

This represents an activity such as "signing a check", or "requesting a bid"

This represents an alternate type of process. You can use the two types of process symbols 
to classify processes into two groups: customer vs. supplier, for example.

This is used to represent a decision that must be made. Lines representing different 
decisions are often drawn coming out of some of the 4 different points in the shape.

This symbol is used to represent information coming in and going out of the system, such 
as a customer order (input) or a product (output).

This symbol is used to represent printed information generated by the system such as an 
invoice or other report (output). 

This symbol is used to connect multiple lines together, or when labeled with a letter, to 
indicate that the flow continues at the connector with the same letter on another page, or 
somewhere else in the system.

This symbol represents the starting or ending point of the system. It is usually labeled 
"Start" or "End".



Welcome to SmartDraw 3! Software You Can Use!
SmartDraw is the easy-to-use program that lets anyone draw great looking flowcharts, 
diagrams and other business graphics. You don't have to be an artist to use SmartDraw.

SmartDraw automatically aligns shapes, lines and text. Its unique built-in library of design 
styles lets you pick professional looking color schemes, shadows, and textures for your 
drawings with the click of a mouse. Libraries of SmartDrawings provide an unlimited 
selection of clip-art, that you can edit or add to.

SmartDraw works as a stand alone program, and as part of the Microsoft Office, Lotus 
SmartSuite and programs that support Object Linking and Embedded (OLE).    You can insert
a SmartDraw drawing directly into Microsoft Word for Windows, using the Insert Object 
command.

The Welcome Dialog controls the following:

To Start lets you choose either to open a new drawing or go to the Open dialog when you 
press OK. You can change this setting permanently, (and stop showing the Welcome dialog)
using the Options command under the Edit Menu. (You must create or open a drawing 
first).

If the Beginning Users box is checked, SmartDraw will pop-up beginning user messages 
the first time that you try something new, to help you understand how it works. These can 
be switched off at any time in any of the messages that pop-up.    The appearance of 
beginning user messages can also be controlled from the Options Dialog.

Tips are helpful hints that bring some of the richer features of the program to your 
attention. You can browse through these using the Next and Previous buttons. The 
Details button presents a help screen describing the tip in more detail. You can look at the 
tips at any time using the Tips command under the Help Menu.

Unchecking the Show Welcome Dialog box will prevent the Welcome dialog from coming 
up the next time that you run the program. This can also be controlled from the Options 
dialog.



Creating, Opening and Saving Files
When you first start the program a new drawing is normally created automatically. Each 
drawing has its own scrollable window. Depending on the settings on your system, you may
have up to 32 different drawings open at the same time.

New drawing windows may be created by pressing the New File button in the tool bar or 
by selecting the New...command under the File Menu. The New File button on the 
toolbar directly opens a new empty drawing. The New... command on the menu presents 
the Template Dialog. This allows you to pick a template as a starting point for your new 
drawing. Templates are already provided for many diagram types. These create new 
drawings with the best settings for this type of diagram, including a document toolbar.

A drawing window is closed using the Close command under the File Menu, or by clicking 
in the window's close box. Any changes you have made to your drawing DO NOT become 
permanent unless you save them. If you have made changes since you last saved, you are 
reminded to save them before the window closes.

Drawings are saved to a file on disk using the Save or Save As commands under the File 
Menu. New drawings must be given a name before they are saved and so either command 
presents the Save Dialog. For drawings that already have a file name, use the Save As 
command only to save to a different file name. To save and retain the same file name use 
the Save command. The Save button on the tool bar executes the save command.

Once a file has been saved to a file on disk it can be re-opened using the Open command 
under the File Menu, or the by pressing the Open button on the tool bar. This presents the
Open Dialog. 

The Options Dialog can be used to set the way new documents are created, and what 
happens when the program starts up.



The Category control shows the available templates by type and Empty Drawing. The named 
categories are the names of file system directories, or folders, within the program directory, where 
the templates in this category are stored. The Empty Drawing category is always present and allows 
you to create a new empty drawing.



Shows a thumbnail of the template currently selected in the Name list. This makes it easy to browse 
through the available templates, until you find the one that right for your task.



Once you have selected the template that you want, pressing the Create button, creates a new 
drawing that is a copy of the template. Changes made to this copy do not affect the original.



Shows a list of templates by name that belong to the category shown above.



Template Dialog 
If you choose    the New... command from the File menu, the Template Dialog is presented.
This allows you to choose the initial design of your new drawing from a selection of 
templates. 

 Category
 Name
 Preview
 Create

You can create your own categories and templates. See    SmartDraw Templates.



Open Dialog
The Open Dialog lets you re-open a drawing that has been previously saved on disk as a 
file. Only documents with names ending in .SDR are normally shown in the list of files to 
open, unless you select another extension using the Files of Type control described below.

Windows 95 and NT 4.0
The File Name box lets you type in a name for the file to open or you can pick one from 
the list above by clicking on it. If you type the name and do not supply a three letter 
extension at the end    (like .SDR) , the current extension is added automatically.
The area above the file name field is an explorer window. To search in other folders, click on
the names shown in this window or the drop down list above it. Use the context sensitive 
help in the dialog itself to learn about the details of this standard behavior. SmartDraw 
remembers the last folder you used to open or save a file with this dialog and automatically
sets the folder there when you use it again.

Windows 3.1 and NT 3.51
The File Name box lets you type in a name for the file to open or you can pick one from 
the list below by clicking on it. If you type the name and do not supply a three letter 
extension at the end    (like .SDR) , the current extension is added automatically.
The Directories list shows the current directory that the File Name list is showing. To 
search in other directories, double click on the names shown in this list. SmartDraw 
remembers the last directory you used to open or save a file with this dialog and 
automatically sets the directory there when you use it again.
The Drives control shows the letter of the drive that the File Name list is showing. Use this 
control to change drives by clicking on it and picking another from the list.
The Network button, if you have one, lets you browse your network and connect other 
drives. Non-networked users do not have this button.

The Files of Type control changes the extension of the files shown in the File Name list. 
Normally this is "SmartDraw File" (SDR). The second choice, SmartDraw Template, 
opens files with the extension SDT. These files are the same as SDR files but they open as 
an untitled copy, leaving the original intact. This is useful if you want to create files with 
your own initial settings, or with a set of initial shapes, to serve as the starting point for 
other drawings. SmartDraw ships with a broad selection of sample templates. These are 
stored in "category" sub directories. The best way to open these is to use the Template 
Dialog, which allows you to browse through each category and to see a "thumbnail" of each
template before you open it. You can open the Template Dialog by using the New... 
command under the file menu.

The OK button confirms your choice of file and puts away the dialog. The Cancel button 
puts away the dialog without selecting a file. 

See Also: Creating, Opening and Saving Files



Save Dialog
The Save Dialog lets you save your current drawing to a file on disk. Files can be re-opened 
later for further work. Each file must be stored with a file name you give it. 

The File Name box lets you type in a name for the file, or pick one from the list below by 
clicking on it. If you type the name and do not supply a three letter extension at the end    
(like .SDR), the current extension is added automatically. Names can be longer than 8 
letters.

Windows 95 and NT 4.0
The area above the file name field is an explorer window. To search in other folders, click on
the names shown in this window or the drop down list above it. Use the context sensitive 
help in the dialog itself to learn about the details of this standard behavior. SmartDraw 
remembers the last folder you used to open or save a file with this dialog and automatically
sets the folder there when you use it again.

Windows 3.1 and NT 3.51
The Directories list shows the current directory that the File Name list is showing. To 
search in other directories, double click on the names shown in this list. SmartDraw 
remembers the last directory you used to open or save a file with this dialog and 
automatically sets the directory there when you use it again.
The Drives control shows the letter of the drive that the File Name list is showing. Use this 
control to change drives by clicking on it and picking another from the list.
The Network button, if you have one, lets you browse your network and connect other 
drives. Non-networked users do not have this button.
The Save As Type control changes the extension of the files shown in the File Name list 
and the type of the file saved. SmartDraw File has an extension SDR and is the usual 
choice. SmartDraw Template saves the current drawing as SmartDraw Template. This is 
the same as a normal file but with the extension SDT. When template files are opened, an 
untitled copy is made and the original is left closed. When saving as a template, the 
drawing retains its current file name.

The Template Dialog shows only templates that are stored in sub directories of the program
directory. If you want to create your own template, be sure to save it in one of the template
sub directories, or create a new sub directory of your own (using the Windows file manager)
to create a new template "category" and save it there.

The OK button confirms your choice of file and puts away the dialog. The Cancel button 
puts away the dialog without selecting a file. 

See Also: Creating, Opening and Saving Files



The Program Toolbar
SmartDraw usually shows a row of buttons under the menu bar. This is called the 
Program Toolbar. It can be shown or hidden by selecting the Show Toolbar command 
under the View menu.

The top row of buttons are short cuts for the menu commands. To find out what each one 
does, hold the cursor over a button for a second or more. A small yellow window will pop-
up, describing its purpose. This is called a ToolTip.

The buttons in the second row are used for drawing. One of these buttons is usually pushed
in. What happens when you click with the mouse in the drawing depends on which of these 
buttons is currently pushed in.

 When the arrow button is pressed, clicking in the drawing selects, moves or grows existing 
objects.

 When the text    button is pressed, clicking in drawing begins a new background text 
object. Clicking in a shape opens it for text entry.

 When the line button is pressed, clicking and dragging in the drawing draws a straight line.
Dragging and Dropping also draws a line.

 When the segment line button is pressed, clicking and dragging in the drawing draws a 
segmented line. Dragging and Dropping also draws a segmented line.

 When the arc line button is pressed, clicking and dragging in the drawing draws an arc. 
Dragging and Dropping also draws an arc.

 When the connector line button is pressed, clicking and dragging in the drawing draws a 
connector. Dragging and Dropping also draws a connector.

The remaining buttons draw the shape that they show. The shape buttons can be 
configured to show any of the 24 standard shapes, and you can control the default size and
proportions of the shapes that are dragged and dropped. This is done by double clicking on 
the button, or by first selecting the button and then selecting the Toolbar item under the 
Edit menu.



Undo
The Undo command reverses the most recent operation. If used, the command changes to 
Redo, which returns the program to its state before the undo command was used.    
Repeated use of Undo, toggles the program between the current state and the state before 
the most recent operation. 

If the command is gray, there is no previous state to return to.



Drawing Shapes and Lines
There are two ways to draw both shapes and lines:

Drag and Drop
This method requires only one mouse click and gives you a shape or line with a standard 
size and shape. 

To add a rectangle shape, first click on the rectangle button on the toolbar without letting
go of the mouse button. Still holding down the mouse button, move the cursor onto your
drawing. (This is called dragging with the mouse.) A rectangle shape follows the cursor. 
Once you let go of the mouse button, a new rectangle is added to your drawing.

The size of the shapes you drag from the toolbar can be set by double-clicking on the 
shape button. This presents the Edit Toolbar Dialog. Lines created this way are always the 
same size and shape. (Lines are usually drawn using the Pencil method, described below). 
SmartDrawings can also be dragged and dropped from the SmartDrawing window.

Pencil
The pencil method requires two clicks but gives you full control over the size and shape of 
the object that you draw. 

To add a rectangle shape using this method, first click on the rectangle button in the 
toolbar, and then let go of the mouse button. As the cursor is moved into the drawing 
window it changes to the pencil cursor. Now if you click in the drawing window and keep 
the mouse button pressed and move the mouse, a rectangle is drawn, as if the mouse were
a pencil. This method can be used for shapes, lines and SmartDrawings.

For shapes that can be stretched to any proportion, like rectangles, perfectly square 
versions can be made using the pencil draw method. To do this, simply hold down the Ctrl 
key while drawing the shape. This trick with the Ctrl key also applies when re-sizing a shape
with the mouse.

Sticky Tool Selection
Normally, after you have drawn an object using the pencil method, the selection (pointer) 
tool is selected automatically. If you want to draw several copies of the same kind of object,
you can force the drawing tool that you are using to remain selected by holding the shift 
key down the first time you click on it. Holding the shift key down when you select any 
drawing tool, causes it to remain selected until you click on another tool, or drag and drop a
shape.

Colors and Borders
New objects have properties that match the most recent changes made to the drawing. If 
you change the fill color of a shape to blue, and then create a new one, it will be initially 
filled with blue. If no changes have been made using the menus, the colors of new objects 
match the color and shadow style selected for the drawing.



Using Connectors
One of the most powerful features of SmartDraw is the use of Connectors to create 
regular arrangements of shapes. Examples include organization charts, fishbone diagrams, 
network diagrams and even flow charts. 

Connectors are special line objects that both shapes and other lines may link to. A 
connector is programmed to arrange the objects linked to it in a particular pattern. As 
shapes are linked to a connector, the other shapes already linked to it adjust to 
accommodate the new shape and maintain the arrangement. In the example below, a new 
shape is added to a connector that maintains a horizontal organization chart arrangement.

The new shape (white) is dropped between the two existing shapes and is automatically 
inserted between them.

Using Connectors in a Flow Chart
Linear connectors can be useful as components in a flow chart. A Linear connector 
connects shapes in either a perfectly horizontal or vertical line. To branch, other connectors
can be linked to the shapes attached to the first connector. Normal segmented lines can 
also be used to create additional connections:

Dropping a single shape on the horizontal connector inserts the shape and reformats the 
whole diagram in one step!
See also: Adding Connectors,    Adding Shapes to Connectors, Connector Shape and 
Appearance.



Adding Connectors to a Drawing
Connectors are added to a drawing in the same way any other object is added: using drag 
and drop or the pencil drawing method.

SmartDraw offers a Connector tool on the Program Toolbar. 

Dragging an object from this tool creates a horizontal connector with a linear arrangement. 
Holding the Shift key down while you drag creates a vertical connector.
Many of the diagram templates also offer connectors with other arrangements in their 
document toolbar. For example, the organization chart template offers a selection of 
connectors suitable for drawing organization charts. 
See also: Using Connectors, Adding Shapes to Connectors, Connector Shape and 
Appearance.



Changing Connector Shape
Once you have added a connector to a drawing, you may change the arrangement it 
maintains (or its shape) using the Change Connector Shape command on the Line 
Menu. (This replaces the Change Line Shape command when a connector is selected). 
menu.

The Flip command can also be used to create additional variations.

When no shapes are linked to a connector, it appears as either a vertical or horizontal line. 
Its arrangement does not become apparent until two or more shapes have been linked to it.
See also: Using Connectors, Adding Shapes to Connectors, Adding Connectors, and 
Appearance.



Adding Shapes to Connectors
When a shape or line is moved close to a connector, link points are displayed and the 
outline of the moving object jumps to the closest one, showing its position if linked. 
Releasing the mouse links the object to the connector, inserting the object at the link point.
Moving a shape away from the connector disconnects it and the shapes still linked to the 
connector move together to fill the space.

Lines (and other connectors) can also be linked to connectors. This can be used to make 
more elaborate diagrams made up of multiple connectors linked to each other: 
See also: Using Connectors,Adding Connectors, Connector Shape and Appearance.



Changing the Appearance of Connectors
There is always equal amounts of space between the edges of shapes linked to a 
connector. This spacing [C] is controlled using the grow handles at each end of the main 
connector line. The length of the lines connecting the main line to each shapes is controlled
by grow handles at the end of the first and last of these lines [B].The length of the line 
connecting the connector to another object [A] is controlled by the grow handle at the end 
of this line. These relationships are shown in the figure below.

A Connector has the same attributes as a line, and the Line Menu commands can be used 
to set its thickness, color and style.
Connectors also can show arrowheads. These appear on the lines connecting objects to the 
main connector line. Right facing arrowheads always point to the linked objects, 
regardless of their direction relative to the main connector line. Left facing arrowheads 
point towards the main connector line. Connectors do not support associated text or 
rotation.
See also: Using Connectors, Adding Shapes to Connectors, Connector Shape and Adding 
Connectors.



Selecting Objects

Lines and Shapes become selected when they are clicked on with the mouse and the Arrow 
button on the toolbar is depressed. 

Once selected, the colors, borders and other attributes of objects can be changed using the
menu commands. Typing from the keyboard inserts text into selected shapes.

Selected objects are shown with Handles on the corners and sides as shown below.

The most recently selected object is always shown with solid (black) handles and is called 
the Target object. Other selected objects are shown with hollow handles. The target object 
is the one others align with, and become the same size as, when using the Align and Make 
Same Size commands.

Objects that are Linked to other objects have round handles at their connected points.

Selecting Multiple Objects
You can select more than one object at a time. If multiple objects are selected, they move 
as a group. This is useful    when you want to re-position the whole or part of a drawing on 
the page. You can select all objects in a drawing using the Select All command under the 
Edit Menu (Ctrl+A).

There are many ways to select one or more objects:
Clicking on the border of an object selects it and de-selects all other objects. Holding the 
Shift Key (on the keyboard) down while clicking, causes any other selected objects not to 
de-select. Clicking on a selected object with the Shift key depressed, de-selects it (and 
only it).

Holding the mouse button down while dragging the mouse across the drawing window 
draws a temporary dotted rectangle. Any objects completely enclosed by this rectangle are 
selected. Holding the Shift key down while this is done adds these objects to any existing 
selection

Sometimes, it is hard to click on, and select, the object that you want because of other 
objects that lie on top (or in front) of it. There are two ways to overcome this. You can 
select the objects on top and Send to the Back, or you can drag around all of the objects, 
selecting them all. Shift-clicking on the objects in the front now de-selects them, leaving 
only the object you want still selected.

Shapes can always be selected by clicking on their border. Shapes that are not transparent 



can be selected by clicking inside their borders.



Moving Objects
Using the Mouse
Shapes and lines can be moved by clicking on them with the mouse, keeping the mouse 
button pressed down, and moving the mouse. An outline of the object clicked-on follows 
the mouse.

If more than one object is selected, all selected objects move as a group. More than one 
object may also be moved if the object clicked on is linked to others. When a group of 
objects is moved, an outline of the rectangle that encloses the group follows the mouse.

If you want to move an object only in the horizontal or vertical direction, hold down the 
shift key down while you drag with the mouse. Your object will move either horizontally or 
vertically (depending on which direction you move to the greatest extent).

Using the Arrow Keys
The arrow keys can also be used to move an object. First the object must be selected. This 
is usually done by clicking on it. Typing an arrow key then moves the object by 1/100" with 
each keystroke. The right and down arrows move the object to the right and bottom. The 
left and up arrows move it to the left and up. If more than one object is selected, all are 
moved.

Aligning Objects
The Align command under the Draw menu can be used to align all selected objects with the
selected target object.

Spacing Objects Evenly
The Space Evenly command under the Draw menu can be used to arrange a collection of 
objects so that they are separated by equal distances.

Centering the Drawing on the Page
The Center Drawing on Page command, move the entire drawing (not just the selected 
objects) so that it is centered on the page.



Some Objects do not Rotate
The following objects do not support rotation: Connectors, Segmented Lines and Arcs, 
Picture objects that contain bitmaps. Any group that contains these kind of objects also 
does not rotate.



Rotating Objects
All shapes, text and some lines can be Rotated by any angle. You can do this manually by 
selecting the rotation handle that objects capable of rotation show when selected. 

The cursor becomes the rotation shape shown in the margin when positioned over a 
rotation handle.

Clicking on the rotation handle and dragging with mouse rotates the shape about its center.

When the Snap to Grid feature is turned on, the angle of rotation snaps to increments of 15 
degrees (15, 30, 45 and so on..)

You also rotate objects using the Rotate commands on the Draw menu. The Rotate sub-
menu has commands to rotate by 90 degrees in either direction, and to return an object to 
the horizontal position. The Set Angle command allows you to specify the exact angle of 
rotation within one tenth of a degree, via the Set Rotation Angle Dialog. 
The rotation commands on the menu apply to all selected objects. This allows you to rotate 
a group of objects by the same angle. Furthermore, the angle shown in the Set Rotation 
Angle dialog , is the one associated with the last one selected (the target object). 

This feature allows you to align the rotation angle of a group of objects to one particular 
object: Simply select the objects that you wish to align, then, holding the Shift key down, 
select the target object that you wish to align them with. Now select the Set Angle 
command and press OK.

You can rotate straight lines, any shape, and most imported pictures. Segmented lines, 
curves, bitmapped picture objects, and connectors do not rotate. Also, objects linked to 
others do not rotate. (since they cannot maintain their link if they do!) However, you can 
rotate a shape or line before you link it. Objects that do not rotate do not show a rotation 
handle.

When an object is rotated, the text associated with it rotates too. If you want the text in a 
rotated object to remain horizontal, you can change it into a new (rotated) shape, before 
you add text. This is described in Creating Your Own Shapes.



Sizing Objects
You can change the size of a line or shape by first selecting it, and then clicking on one of 
the Selection Handles that appear on its border when it is selected.

Using the Mouse
To change the size of an object using its handles, click on one with the mouse and keep the 
mouse button held down. Then move the mouse. The handle that was clicked-on follows 
the movement of the mouse, changing the size of the object as it does.

Any shape can be stretched to maintain its current proportions, by holding down the Shift 
key while dragging with the mouse.

For shapes that can be stretched to any proportion, like rectangles, perfectly square 
versions can be made by holding down the Ctrl key while dragging with the mouse.

Shapes, like some SmartDrawings and Picture Objects, that normally can only be sized 
proportionately, can be stretched to any proportion, if you hold down the Shift key while 
dragging with the mouse.

Using the Arrow Keys
The arrow keys can also be used to adjust the size of an object. First the object must be 
selected. This is usually done by clicking on it. Typing an arrow key, while holding the down 
the Shift key, then increases or decreases the size of the object by 1/100" with each 
keystroke. The right and down arrows increase the size at the right and bottom. The left 
and up arrows decrease the size at the right and bottom.

These changes may be applied to more than one object simultaneously, if more than one is
selected.

Make Same Size
The Make Same Size command under the Draw menu can be used to make all selected 
objects the same size as the selected target object.

Grouping
Objects may be combined into Groups. When grouped they grow proportionately as a single
object.



Flipping Objects
All objects, except bitmapped images, can be Flipped,    either horizontally or vertically.
Horizontal flipping changes an object as if it were reflected in a mirror down its middle.

Vertical flipping changes an object as if it were reflected in a mirror across its middle.

Note that text is unaffected by flipping.
Flipping can be used to generate even more styles of connectors and segmented lines.



Shapes
Shapes have the following properties, each of which has its own menu, or menu item under
the Shapes menu. Changes made using the Shapes menu apply only to shapes that are 
selected. 

Right Mouse Button
The right mouse button can also be used to change the properties of selected objects. 
Clicking on an object with the right mouse button brings up a context sensitive menu for 
that object.

Fill Color
This determines the color inside the shape. This can be transparent, which means that the 
background of the drawing shows through. SmartDrawings that allow re-coloring, may also 
respond to fill color changes. The fill color command changes any fills in the SmartDrawing 
that are not black.

Shading
This determines the pattern used to fill the inside of the shape. This can be a plain color 
(the first choice on the menu), or any of five hatched patterns. The hatched patterns use 
the border color for the hatching on a background determined by the fill color. If a hatch 
pattern is selected and the border and background color are the same, the border color is 
changed to a contrasting color.

Border Style
A shape may have a border around its edge. This can be dotted, dashed, or solid with 
several thicknesses. Thick borders always grow towards the center of the shape. 
SmartDrawings that re-color respond to border style changes by changing their 
appearance. Those that do not show a border around the rectangle that encloses the 
drawing.

Shapes can also have no border. These are not visible unless their fill color differs from the 
background. Border-less shapes do not show shadows with all but drop shadow styles.

Border Color
This determines the color of a shape's border. If the border has no border, selecting a color 
gives it one. SmartDrawings that re-color respond to border color changes by changing 
their appearance. The border color controls the color of any lines, borders, text or areas of 
black. 

Shape
The shape menu allows you to change the shape of any standard shape to any other. 
SmartDrawings, background text objects or pictures do not respond to this command.

Text Sizing
Shapes may contain text. The details of text editing are described in Entering Text. Shapes 
grow as text is entered. The way the shape grows can be controlled using the Text Sizing 



command.

Shape Sizing
This command presents the Shape Sizing dialog. This controls the way shapes grow and the
case of Picture Objects, whether they adopt the border and fill colors, or retain their own.

Edit Shape Outline
This command breaks a shape into its component lines and curves and is discussed in 
Creating Your Own Objects.



Shape Sizing Dialog
The Shape Sizing Dialog is used to adjust both the way a shape or SmartDrawing grows 
and is affected by selections on the shape menu. It is invoked using the Shape Sizing 
command under the Shape menu.

This dialog does not apply to toolbar shapes. There are two properties to control:

Grow
The four radio buttons control the way in which the shape can be re-sized. 
Proportional objects have only four grow handles (one at each corner) and maintain their 
proportions when re-sized.
Horizontal Only objects have only two grow handles and can be re-sized only in the 
horizontal direction. This is good for objects that represent horizontal lines.
Vertical Only objects have only two grow handles and can be re-sized only in the vertical 
direction. This is good for objects that represent vertical lines.
No restrictions allows objects to grow in all directions without maintaining proportions. 
These objects have the usual 8 grow handles.

Change Colors
Checking this box allows SmartDraw to change the color of the fills, lines, border and text 
that show in a SmartDrawing or a picture object    that contains a metafile. The style and 
thickness of borders and lines can also be changed. These settings are controlled by the 
Shape menu, not the Line or Text menu.

The color of the text, lines and borders follows the Border Color setting. The fills follow the
Fill Color. Transparent fills are not affected by the Fill Color.

If this box is not checked, the drawing behaves like a normal picture object. Applying a 
border style places a border around the object but does not change the contents.

The substitution of colors for lines, fills etc. may not work for all SmartDrawings and picture
objects. If the image contains bitmapped images, these may be unaffected by checking the
color box. If you check this box you should experiment with the object to see the effects of 
color changes. If these are not satisfactory, return to the dialog and uncheck the box again.



Lines
Lines have the following properties, each of which has its own menu, or menu item under 
the Line menu. Changes made using the Line menu apply only to lines that are selected.

Right Mouse Button
The right mouse button can also be used to change the properties of selected objects. 
Clicking on an object with the right mouse button brings up a context sensitive menu for 
that object.

Line Classes
There are three classes of line: straight lines, segmented lines and curved lines. Each has 
its own button on the Program Toolbar.

Straight lines can have any direction. They "snap" to become perfectly horizontal or vertical
if drawn or grown in this direction.

Segmented lines are made up of 1 to 5 segments. These are usually used to Link shapes 
(or other lines) together. When linked to another object, the segment that touches the edge
of the object is always perpendicular to the edge. Hence the segmented line changes its 
shape and number of segments to maintain this relationship with its linked objects. The 
best way to understand this is to experiment with it.

Curved lines are arcs if they are not linked to other objects. They become curved versions 
of the segmented lines when linked.

The shape of linked curves and segmented lines can be adjusted by clicking on the 
selection handles.

Line Style
Lines can be dotted, dashed, or solid with several thicknesses.

Line Color
Lines can have any of the colors on the Line Color menu

Arrows
Lines may have the arrow styles shown in the Arrowhead Dialog.

Line Type
Straight lines may have one of three types: Plain, Chord, Communications Link and Digital 
Link. These are shown below. These types do not apply to curves or segmented lines.



The size of the styled portions of the line can be adjusted by clicking on the selection 
handles at the end of the line segment that crosses the line

Aligning Text with a Line
You can attach text to a line by simply selecting at and typing. The text will remain 
attached to line and can change its orientation to match that of the line, or it can remain 
horizontal. This can be controlled with one of the two Align Text on the Line command 
settings, found on the Line Menu: Along the Direction of the Line, and Horizontally.



This collection of buttons controls the type and displacement of the arrowhead that will appear on the
left end (or top end for vertical lines) of the selected lines.
Note the center position arrows: 



This collection of buttons controls the type and displacement of the arrowhead that will appear on the
right end (or bottom end for vertical lines) of the selected lines.
Note the center position arrows: 



These buttons control the size of the arrows, and applies to both ends of the line.



Shows a preview of a horizontal line linked at each end to a shape with the arrowhead properties that 
reflect the current settings in the dialog.



The two buttons shown for this property control whether the end of a line with an arrowhead is drawn 
its full length or a little short. This is useful when lines are linked to shapes. If the line is displaced it 
does not appear to touch the shape but still remains linked to it. This property can be controlled 
independently for each end of a line, and does not apply to ends with no arrowhead.



Arrowheads
Any line or curve may begin or end with an arrowhead. There are 11 different arrowhead 
styles. These, their size and their placement on the line are changed using the Arrowhead
Dialog. This is presented by the Arrowheads... command under the Line menu. The 
dialog has the following controls:

 Left Arrow Buttons

 Right Arrow Buttons

 Displacement

 Size

 Preview

Controls that are not set.
If two or more lines with different arrowhead properties are selected, the arrowhead dialog 
shows no selection for those controls that have different settings for each line. If no selection
is made for these settings, the properties that they control are not changed. For example, if 
two lines have different right arrows, no right-arrow buttons will be selected when the dialog 
is displayed. If these buttons remain unselected, but the size is increased, then, when you 
press the OK button, both arrowheads will change size but will retain their different styles.



Changing Line Shape
You can change the shape of lines, segmented lines and arcs using the Change Line 
Shape menu. The Flip command can also be used to create additional variations.

You can also change segmented lines into straight lines and curves (and visa versa) using 
this command.



Showing Line Length
Lines can be set to show their length in same units as shown by the rulers. The Show 
Length command under the Line menu, changes any lines that are selected to show their 
current length as an attached text object, or Length Label.

The length label changes its value as the length of the line is adjusted. Changing the ruler 
scale or units using the Define Rulers and Grid dialog also changes the value of the label.

A length label is removed from a line by deleting it.

If you want to use your own units or descriptions, you can attach your own text to any 
length label simply by typing it in. Text that is not part of the length value is preserved as 
the line changes length.

Length labels are used to create automatic dimension lines. There are arrowhead styles 
that can be placed at each end of line to complete the appearance. Segmented and curved 
lines can also show their length. For segmented lines, the length is the distance between 
the ends in the direction of the text label



Colors and Shadows
The Colors and Shadow command, under the Edit Menu, allows you to apply a design 
Style to your drawing.    A style is a color scheme, specifying the color of the drawing 
background, shapes, borders, lines, text and shadows, and a shadow type. Styles are 
selected from the Colors and Shadow Dialog.

Many pre-built styles are provided by SmartDraw. These are listed in the Select a style 
list box. A preview of the style's appearance is shown in the Sample window to the right of 
it. Changing the style selection changes the preview. You can browse through the available 
styles using the up and down arrow keys to change the selection. 

Once you have selected the style that want, press the OK button and the colors and 
shadow styles are applied to your drawing. This is a very quick and easy way to change all 
the colors in a drawing in one operation. You can undo any change you make, or you can 
apply another style to try any number of different "looks".

If you select a shadowed style, shadows are applied to your shapes. Some styles also apply
the same kind of shadow to lines and to text. The 3D styles give the raised and sunken 
looks common in Windows dialogs.

You can control whether a shadowed style applies the shadows to lines and text by 
checking the boxes in the shadow section of the dialog:

 Apply to Lines

 Apply to Text

 Reverse Text Shadow

You can also control what colors are applied:

 Apply to Lines

 Apply to Fills

Pressing the Define button in the dialog allows you to add your own styles, or to modify the 
standard ones.

See Also; Defining Color and Shadow Styles



This option is only available if the raised or sunken 3D shadow styles are chosen. Checking this box 
applies the reverse text shadow: Raised if the shape shadow is sunken, sunken if the shape shadow is
raised. This can give an interesting effect.



Checking this box applies the shadow style selected to text as well as to shapes. This is only visible if 
a shadow style is selected. Text does not look good shadowed unless it has a point size of 18 or 
greater.



Checking this box applies the shadow style selected to lines as well as to shapes. This is only visible if
a shadow style is selected, and is forced to be on for the raised and sunken shadow styles.



Checking this box applies changes to the fill colors and text colors of shapes.



Checking this box applies changes to the colors of borders and lines.



The four push buttons show the current angle for the shadow. Pressing one changes the selection to 
the angle shown on its face. These controls are only visible if one of the shadow styles in the right 
column of the shadow control is selected.



The six push buttons show the range of shadow styles available with the top left button representing 
no shadow. If a shadow style in the right column is selected, the angle of the shadow can also be 
controlled using the controls labeled Angle.
Shadows can be applied optionally to lines and text. Check boxes control these selections.



Seven color panels are displayed showing the current color scheme. Pressing on any color panel with 
the mouse displays the color menu. Use the menu to change the color selection. 

The selection shown on the left represents the Transparent color.
The highlight color is only used by the raised and sunken three dimensional shadow styles.



This button is active when the name in the Name field matches the style selected in the list. Pressing
it removes the selected style from the list.



This button is active when the name in the Name field matches the style selected in the list. Pressing
it changes the selected style to the current color and shadow settings.



This button is active when the name in the Name field does not match the style selected in the list, 
and the settings for colors and shadow have been changed. Pressing it adds the current color and 
shadow settings as a new style.



The text in the name field is the current name of the style being edited. If this matches the name of 
the style that is shown selected in the list, the Change button is active, and the current style is 
changed if it is pressed. If the name does not match the selected name in the list, the Add button is 
active and pressing it adds a new style to the list. If there is nothing typed in the field, both buttons 
are inactive.



This area shows a preview of the current style as the selection in the list is changed, and as the 
settings for the selected style are changed.



This button becomes active when the name of the selected style has been changed, but the 
parameters have not. Pressing it renames the current style.



Selecting an item in this list selects the style for editing. The style's name is copied into the Name 
field, and the Change button becomes active. Any changes to the previously selected item's style are
canceled.



Defining Color and Shadow Styles
You may change existing styles or add new styles with the Define Colors and Shadows 
Styles dialog.

 Select a Style To Edit

 Sample

 Name

 Add

 Change

 Rename

 Delete

 Colors

 Shadow

 Angle

 Apply to Lines

 Apply to Text

 Reverse Text Shadow

Changes made in this dialog do not become permanent unless the OK button is pressed. 
The newly defined styles are then available in the Colors and Shadow Dialog.



Background Color
The background of the drawing itself may be colored. The background color is changed 
using the Background Color command under the View menu. One of the selections is 
transparent. Drawings with transparent backgrounds differ from those with white 
backgrounds only in the way their pictures are exported. Drawings with transparent 
backgrounds export transparent pictures that acquire the background color of the 
document that displays them. Drawings with white backgrounds export pictures that have 
opaque white backgrounds, no matter where they are displayed.

Drawings exported in bitmapped formats are always opaque. 

The background color is one of the settings specified in the Color and Shadow style.



Hiding Shadows
Whether shadows appear on shapes, lines and text is controlled by the style selected using 
the Colors and Shadows Dialog. Normally if a shadowed style is selected it applies to all 
shapes, and may or may not apply to lines and text. You can, however, override these 
choices for individual objects.

Using the Hide Shadow command, under the Draw menu, turns off any shadows for 
objects that are currently selected. If objects are selected that already have hidden 
shadows, the menu item changes to Show Shadow, and selecting it turns the shadows 
back on for the selected objects.

Show Shadow has no effect if the current style does not normally apply shadows to the 
objects in question.

The Shadow command under the Text menu, has an effect on text shadows similar to the 
effect Hide and Show Shadow have on the shadows of objects. Selecting it toggles text 
shadows on and off for selected objects, as shown by the check mark next to its menu 
item. This command has no effect if the current style does not specify text shadows. 



Entering Text
There are two ways to enter text: Inside a shape or in a background text object.

Entering Text Inside Shapes
Text may be entered inside the 24 standard shapes that appear on the toolbar and inside, 
or underneath, many SmartDrawings. As text is added to a shape it fills up and grows to 
accommodate the text.

If a shape is selected, just starting to type opens it for text entry. Shapes can also be 
opened for text entry by double clicking on them, or by pressing the text button on the 
toolbar and clicking once on the shape.

Entering Background Text
If the text button on the toolbar is pressed in, then clicking in the background of the 
drawing opens a text entry session. Text entered forms a new object called a Background 
Text Object. This is essentially a rectangle shape with no border.

Background text objects may be selected and opened for further text entry like any other 
shape. They may have a border and colors like any other shape. They do have some 
properties that differ from the rectangle shape however.

Text objects align to the Snaps according the baseline of the first line of text, and not to 
their top left corner like other shapes. They are deleted if all their text contents are deleted.
They can also be like any other object.

Entering and Editing Text
When a shape or background text object is opened for text entry, the standard Windows 
insertion point appears. This is a flashing vertical line. All of the normal Windows text 
editing conventions apply: Dragging with the mouse selects text (shown as inverted). 
Selected text can be cut, deleted or copied. The font, size, style and color of selected text 
can be changed using commands on the Text menu.

Adding Text to Lines
Line objects may also have text labels. See Adding Text to Lines.

Right Mouse Button
The right mouse button can also be used to change the properties of text. Clicking on text 
with the right mouse button brings up a context sensitive text menu.

See also: Selecting a Typeface,    Text Alignment, Inserting Symbols



Adding Text to Lines

Lines can also have their own text. If you select a line and begin typing, a background text 
object will open that is attached to the line, normally in the center. This text object will 
remain attached to line and will change its orientation to match that of the line, or it can 
remain horizontal. This can be controlled with one of the two Align Text on the Line 
command settings, found on the Line Menu: Along the Direction of the Line, and 
Horizontally.

The text is positioned on the line according to the current text Alignment, selected on the 
Text menu. Text that is centered vertically is created with an opaque background that hides 
the line underneath. Other vertical alignments cause the text to be create with a 
transparent background so that the text shows through. You can show the line through the 
text (or visa versa) by selecting the text object itself and changing its fill color, using the 
Shape menu.

SmartDrawings that are set to have text entered above or below the shape behave in a 
way very similar to lines. Selecting the shape and starting to type creates a background 
text object that remains linked to it.

Showing a line's length creates an automatic text object for a line.



This shows a list of styles (weights) for the selected font.    If no style is shown selected, then the 
range of text selected has more than one style. Leaving this list un-selected will result in no change to
the style over the selected range.



This shows a list of sizes for the selected font. If the size you want is not listed you may enter it in the
editable field. If no size is shown selected, then the range of text selected has more than one size. 
Leaving this list un-selected will result in no change to the size over the selected range.



This shows a list of all True Type fonts in the system. If no font is shown selected, then the range of 
text selected has more than one font. Leaving this list un-selected will result in no change to the font 
over the selected range.



Selecting a Typeface
There are two ways in which the font, size and style of text can be changed: When a text 
entry session is active, and range of text is selected, and when a shape containing text is 
selected.

In both cases the Typeface command under the Text menu presents the standard Font 
Dialog. Selecting a font, size, style combination from this dialog applies the new typeface 
either to the range of text selected or to all the text in the selected shape.

Press the buttons below for an explanation of the controls in the dialog:

 Font

 Size

 Style

The sample window shows a preview of the typeface selected.



Text Alignment
Text can be positioned inside a shape so that it aligns with the left edge, the right edge, or 
is centered horizontally. It can also be flush justified so that it aligns with both the left and 
right edges of the shape. Vertically, the text can be positioned so that it aligns with the top 
edge, the bottom edge, or is centered vertically. The four horizontal and three vertical 
settings can be combined into a total of 12 combinations. These 12 combinations are 
shown graphically in the Alignment menu under the Text menu.

The Alignment command can be used when a shape that contains text is selected, or when 
a shape is open for text entry. It affects the way text is displayed within the shape and the 
way the shape grows when text is added. (See Text and the Sizing of Shapes). When the 
text is open for editing, different paragraphs can be assigned different alignments.

Aligning text in a background text object has little noticeable affect because there is no 
extra shape size to position the text relative to.

The alignment does control the position of a text object associated with a line, however. 

Flush alignment is similar to left alignment except that wrapped lines have smooth right 
edge as well as left edge. Left aligned text has a ragged right edge.



Bulleted Text
The Bullets command, under the Text menu automatically formats text with one of four 
bullet styles, with proper indentation. This can be applied to the entire shape, or individual 
paragraphs within a shape.



Insert Symbol
The Insert Symbol command, under the Text menu, allows you to quickly insert a 
character in a particular font. It presents the Insert Symbol Dialog and is active only 
when a text entry session is open.    Selecting one of the symbols from the dialog inserts it 
into the stream of text.

Select a symbol by clicking on it. Pressing OK, or a double-click inserts a symbol and closes 
the dialog.    If the font drop-down list shows Normal Text, the typeface of the inserted 
character is the same as the current font. If a specific font is selected, the inserted symbol 
has this font.

You can add new fonts, or remove them from the list, using the Add Font and Remove 
Font buttons. 



Text and the Sizing of Shapes
Regular shapes, SmartDrawings and background text objects all grow if more text is 
entered than will fit inside them. There are three ways that they can grow.

Horizontally and Vertically
This is the default for most shapes. The shape grows so as to maintain its proportions.

Horizontally
This is the default for background text objects and the text that appears below or above 
pictures and SmartDrawings. New text is added on the current line. Wrapping occurs only 
when an <Enter> is typed.

Vertically
Text "wraps" within the width of the shape, like a word processor does when the text 
reaches edge the of the page. The shape grows vertically as new lines are added.

The Grow Direction
The direction that the shape grows is determined by the Alignment command under the 
Text menu. A shape maintains a fixed point according to its text alignment. If its text is 
centered, the center of the shape remains fixed and it grows outwards from the center. Left 
justified text remains fixed at its left edge and grows on the right. Top justified text grows 
downwards and so on.



Arranging Lines and Shapes
Use Snaps
The Use Snaps command under the Draw menu, toggles the snap mechanism on and off. 
When Snaps are on, and the menu item is checked, the edges of shapes and lines 
automatically align with the tick marks on the rulers as they are created, moved, or re-
sized. This makes aligning the edges of objects, when simply dragging them with the 
mouse, very easy.

Align
The align commands under the Draw menu align the edges of selected objects with the 
target object. The Left and Right commands align the left and right edges of the selected 
objects with the left or right edge of the target object respectively. The Center Vertically 
command aligns the point centered between the left and right edges. Top, Bottom and 
Center Horizontally work similarly but in the vertical direction.

Make Same Size
This command is used to re-size all the selected objects so that they have the same Width,
Height or Both, as the target.

Space Evenly
This command moves the selected objects so that they are separated from each other by 
the same amount of space, either Horizontally, Vertically or Both. The objects on the 
outside of the selected group do not move.

Grouping
Objects may be combined into Groups using the Group command. When grouped the 
collection of objects within the group behave as a single object for the purposes of moving, 
growing and property changes. Ungroup reverses the Group command. 

Centering the Drawing on the Page
The Center Drawing on Page command, move the entire drawing (not just the selected 
objects) so that it is centered on the page.

Bring to Front and Send to Back
Objects (shapes and lines) may lie on top of other objects. You can change the front to back
order of the objects in your drawing using the Bring to Front or Send To Back commands
under the Draw Menu. Bring to Front moves any selected objects in front of the non-
selected objects. Send to Back does the reverse. These commands have no noticeable 
effect unless objects overlap one another.

Lock Object
Selected objects may be Locked and unlocked using the Lock Object command. Locked 
objects show their selection with gray handles instead of black and cannot be moved until 
they are unlocked. This is useful if you want to place an object behind others and don't 
want to accidentally move it while clicking on the objects in front of it. Locked objects 
cannot be opened for text editing. Their properties (color etc.) can be changed using the 



menu commands however.

Allowing Shapes and Lines to Link
See Linking.



Centering the Drawing on the Page
The Center Drawing on Page command under the Draw menu can be used to move all 
the objects in the drawing so that they are centered in the minimum number of pages 
needed to print them. The drawing is also moved to the top-left of the drawing area.    This 
commands applies to all objects, not just selected objects.

If your drawing does not fit on one page, you can still print it on a single page by checking 
the Print on One Page check box in the Print dialog.



Attach
Using the Attach command under the Draw menu allows you to associate any shape or 
line with another SmartDraw drawing file, an address on the World Wide Web, another 
applications document, or even a program command line.

The Attach a File command displays the Attach Dialog. Here you can choose to attach a 
SmartDraw drawing, a web address, a document, or a program to the currently selected 
object. You enter the file name, the web URL, or the program command line of the file that 
you want to attach into the name field. You can also use the Browse button, to search for a
particular file. This presents the standard Open Dialog. 

Once you select a file using the Attach dialog,    it is attached to the currently selected 
object. From this point on, if you select this object and use the Open Attached File 
command (or type the    F11 Key as a short cut), the attached file will be opened and 
brought to the front. You can break this association by selecting the object and using the 
Clear Attachment command.

You can only use the Open Attached File and Attach a File commands when a single 
object is selected. You can use the Clear Attachment command when more than one 
object is selected. The attachments will be cleared from all selected objects.

Shapes and lines with drawings attached to them are marked with a special symbol that 
consists of a plus sign inside a small box. 

Double-clicking on this symbol opens the attached file.

The Attach feature can be used to create hierarchical or nested drawings. Say, for example,
that you are creating a flowchart for a process which includes one very complex step. On 
your summary (or high-level) flowchart, the complex step may be represented by a single 
shape. But attached to that shape could be a detailed flowchart illustrating the complex 
process. Double-clicking on the attach symbol opens up the detailed chart represented by 
the shape.

Attaching a web address is useful if you want to associate a symbol with a web site. For 
example, in a network diagram you could attach the web address of the manufacturer of 
the piece of hardware represented by a symbol. 

You can also attach a page or more of notes to any shape in a chart by attaching a word-
processing document to it. You can also attach a help file. 

Symbols retain their attachments when added to SmartDrawing Libraries. As long as the 
attached file has the same pathname, relative to the program directory, the attachments 
will work when the symbol is added to a new document. This means that you can associate 
pages of notes, or a web URL to any symbol in a library.





Searching for Symbols by Name
Pressing the Find button in the Open Library dialog, opens the Find SmartDrawing 
dialog, and offers a means of searching for symbols by name.    Entering a word in this 
dialog and then pressing OK finds all the libraries that contain a symbol that has this word 
in its name or in its keyword description. The names of these libraries are displayed in a 
special category called Results of Find. The most recent list of libraries found in a search 
is remembered, even between program sessions, until the next Find operation is 
performed.

You can narrow a search by entering more than one word in the Find dialog . Only libraries 
that contain ALL of the words entered are found.



SmartDraws libraries are organized into a dozen or more categories. These are shown in the drop-
down Category List. Each category contains a group of libraries whose names are shown in the 
scrolling list control. 



The scrolling list shows the names of all of the libraries in the currently selected category.As each one
of the names in the list is selected, a preview of the symbols the library contains is displayed on the 
right. This makes it easy to browse through all the libraries looking for a particular symbol.



This shows a preview of the symbols contained in the selected library. Tooltips show the symbol name
if you rest the mouse over one of the buttons.



Displays the Find SmartDrawing dialog, offering a means of searching for symbols by name.



Presents a standard file opening dialog allowing library files, outside of the LIBRARY folder in the 
program directory, to be opened.



Open Library Dialog
The Open SmartDrawing Library command under the Libraries Menu is used to find 
and open SmartDrawing Libraries. This presents the Open Library dialog.

 Category

 Name

 Preview

 Find

 Browse

You can search for a library by name, by pressing the Find button.



SmartDrawings
SmartDrawings are symbols that can be added to SmartDraw drawings, just like any of the 
standard shapes on the toolbar. 

SmartDrawing Libraries
Collections of SmartDrawings are stored in SmartDrawing Libraries. These are disk files. 
SmartDrawing Libraries are usually collections of symbols that are used by a particular type
of diagram. SmartDraw has dozens of libraries with symbols for flow charts, computer 
networks, space planning, clip art, and many more. 

SmartDrawing Windows
Libraries are opened using the Open SmartDrawing Library command, under the Libraries 
menu. Once a library has been opened, its symbols are displayed in a SmartDrawing 
Window that floats above the program window. Up to 16 SmartDrawing windows can be 
open at the same time, each showing the contents of a different library. 

The SmartDrawing window shows rows of buttons, each displaying a different 
SmartDrawing from the current library. The name of the current library is shown in the 
window title bar. The SmartDrawing window also has its own menu. This, and the Libraries 
menu on the main menu bar,    is used to change libraries, create new ones and edit the 
contents of the current library.

Document Toolbar
A SmartDrawing window can be changed into a Document Toolbar and visa versa. This is 
done by dragging a SmartDrawing window to the top of a document window. 

Adding SmartDrawings to a drawing
Clicking on one of the symbol buttons is the same as clicking on a shape button in the 
Program Toolbar. Clicking and dragging, drags and drops a copy of the SmartDrawing 
shown on the button into the drawing. Clicking to select the button changes the cursor to a 
pencil, and drawing with the pencil (by holding down the mouse and dragging) draws a new
copy of the drawing.

See also: SmartDrawing Libraries, Opening SmartDrawing Libraries, Document Toolbars, 
Creating Your Own Libraries, and    Editing SmartDrawings



Opening SmartDrawing Libraries
The Open SmartDrawing Library command under the Libraries Menu is used to find 
and open SmartDrawing Libraries. This presents the Open Library dialog.
The Open Library dialog allows you to browse through the many libraries that ship with 
SmartDraw and to search for symbols by name. 

The Libraries menu lists the most recent libraries that were opened, and shows a check 
mark next to the names of those that are currently open. Selecting one of these menu 
items, either opens it or brings it to front.

Any SmartDrawing window that was left open when the last drawing was closed is always 
re-opened automatically (in the same location) whenever a drawing is opened again.
Like SmartDraw documents, you can also open a library file by dragging it from the 
Windows Explorer (or File Manager) and dropping anywhere in the program window.



Document Toolbars
A SmartDrawing window can be changed into a document toolbar and visa versa. This is 
done by dragging a SmartDrawing window to the top of a document window. As the window
approaches the toolbar area, its gray outline changes toolbar shape. Releasing the mouse 
changes it to a document toolbar. This is called docking the window.

The process is reversed by dragging the toolbar away from the top of the document 
window, so that it resumes its SmartDrawing window-like appearance.

One document can have only one toolbar. Attempting to dock a second toolbar will fail. 
However, you can dock a different toolbar to each open document.

When a document is maximized to fill the entire program window, the document toolbar 
appears as a third row of button below the program toolbar.

Bringing a new document to the front, with a different document toolbar, changes the third 
row, however.

A document toolbar behaves just like a SmartDrawing Window: You can add symbols to it 
using drag and drop, you can transfer symbols to and from other libraries, and so on. 

When a document is saved, its relationship to its toolbar is saved too, and the next time it 
is opened, the toolbar remains in place. Many of the SmartDraw templates use this feature 
to automatically open their own toolbars when they are used.

The most recently docked SmartDrawing Library becomes the default toolbar for all new 
documents that dont already have their own toolbars. You can use this feature to create 
your own permanent third row to the program toolbar: Simply dock your favorite library, 
and all new documents will automatically show this toolbar.



Creating Your Own Libraries
You can create your own SmartDrawing libraries using the Create New Library command 
in the Libraries menu. This presents a standard Save File dialog. If you enter name for the 
new library and press OK, an empty library with that name is created and opened.

Unless you create the new library file in one of the existing category folders within the 
LIBRARY folder in the program folder, it will not show using the Open Library dialog.

The new SmartDrawing window will show the new name but, because it is empty, it will 
show no buttons. 

Adding New Symbols to Libraries
Adding a new symbol to a library is a simple Drag and Drop operation. Any object, or 
collection of objects    dragged from a SmartDraw document window and dropped onto a 
library window, may be added as a new symbol. 

Doing this is an extension of a standard object move operation. While objects are being 
moved using the mouse, positioning the cursor over an open library window changes it to 
the Library Drop Cursor, shown at the left. Releasing the mouse with this cursor showing, 
presents the Edit SmartDrawing dialog, showing a new symbol, composed of the objects 
that you were moving, in the Image window. Pressing OK in this dialog, adds the symbol.

You can also use almost any Windows drawing program to create new SmartDrawings. All 
that is required is to be able to load an image to the Windows clipboard in standard 
Windows metafile format. Metafiles are placed on the clipboard when you use the Copy 
command under the Edit menu in most graphics programs. 

To add a symbol from another program to a currently open library, first copy it to the 
clipboard and then select the Add New SmartDrawing command under the Libraries 
menu. The Edit SmartDrawing dialog is presented just as if you had dropped an image 
onto the library.

Transferring Drawings Between Libraries
Copying a symbol from one library to another is also a simple drag and drop procedure: 
Click on the drawing that you want to copy and drag with the mouse, just as if you were 
going to drag a copy into the drawing, but instead of releasing the mouse button over the 
drawing window (which adds a copy to the drawing), release it over the SmartDrawing 
window, or document toolbar, that you want to copy the SmartDrawing to.



 For Automatic SmartDrawings, checking this box causes copies of this symbol added to a drawing 
to adopt the current document color scheme. Leaving it unchecked initially preserves its colors. The 
colors and other properties of Automatic SmartDrawings can always be changed.
For Non-Automatic symbols, checking this box allows SmartDraw to change the color of the fills, 
lines, border and text that show in the SmartDrawing. The style and thickness of borders and lines 
can also be changed. These settings are controlled by the Shape menu, not the Line or Text menu.
The color of the text, lines and borders follows the Border Color setting. The fills follow the Fill 
Color. Transparent fills are not affected by the Fill Color.
If this box is not checked, the drawing behaves like a Picture Object. Applying a border style places a 
border around the SmartDrawing but does not change the contents.
The substitution of colors for lines, fills etc. may not work for all SmartDrawings. If the image contains
bitmapped images these may be unaffected by checking the color box. If you check this box you 
should experiment with a copy of the SmartDrawing to see the effects of color changes. If these are 
not satisfactory, return to the dialog and uncheck the box again.



The Image window shows the SmartDrawing image against a grid of green lines. A dotted border 
shows the edges of the drawing rectangle. If Automatic is NOT checked:
Each drawing has 16 Connect Points shown as solid black circles. These are the points at which 
lines and other shapes will Link to this drawing. Clicking on the circles and dragging with the mouse 
button held down allows you to move them. The connect points should be arranged on the borders of 
the drawing. To be active, connect points must lie outside the margin lines (whether text is entered 
Inside the Drawing or not).
You can finely adjust the position of connect points using the F5, F6, F7 and F8 keys. The point most 
recently clicked-on, moves left, right, up and down respectively by 1 pixel, when these keys are 
typed.
When the text setting is Inside the Drawing, four margin lines appear. These can be moved by 
clicking on the square handles at each end and dragging. By default these are set to create the 
smallest text entry area possible between all four lines. This should be expanded to allow the largest 
area that still forces all text to lie within the borders of the shape. When text is entered    Above or 
Below the drawing, the margin lines are ignored.



SmartDrawings can display text. This text can be Inside the drawing like the standard 24 shapes, or
Above or Below it. The fourth choice, No text, means that the drawing will not respond to the 
normal text entry commands.
If    Inside the Drawing is selected, four margin lines appear inside the Image window. These should
be adjusted so that the text area within the four lines does not overlap the boundaries of the 
SmartDrawing.
This setting is grayed out for Automatic SmartDrawings.



The four radio buttons control the way in which the SmartDrawing can be re-sized. 
Proportional drawings have only four grow handles (one at each corner) and maintain their 
proportions when re-sized.
Horizontal Only drawings have only two grow handles and can be re-sized only in the horizontal 
direction. This is good for drawings that represent horizontal lines.
Vertical Only drawings have only two grow handles and can be re-sized only in the vertical direction.
This is good for drawings that represent vertical lines.
No restrictions allows drawings to grow in all directions without maintaining proportions. These 
drawings have the usual 8 grow handles.
This setting is grayed out for Automatic SmartDrawings.



You can enter an optional name for the SmartDrawing in this field. The Names command under the 
SmartDrawings menu changes the buttons in the SmartDrawing window to show the names you 
assign to each SmartDrawing instead of their picture.
Any words typed after a semi colon(;) are not displayed in Tooltips or in the button, but are used by 
the    "search by name" feature.



The width and height fields control the size of the SmartDrawing when it is created using Drag and 
Drop. If the Grow setting is set to Proportional, changing one value changes the other, so as to 
maintain the same proportions.
This setting is grayed out for Automatic SmartDrawings.



This checkbox controls whether a symbol retains its SmartDraw native format and uses the automatic
settings associated with its objects (Automatic format), or displays a Windows metafile image and 
uses the settings applied using this dialog (Metafile format).

Symbols created in SmartDraw itself can have either format. Symbols created outside SmartDraw 
cannot have automatic settings and so for these symbols the Automatic checkbox is unchecked and 
disabled.



Editing SmartDrawings
SmartDrawings are regular Windows metafile pictures with special additional properties 
used by SmartDraw to control they way they change size, color and display text. The Edit
SmartDrawing dialog is used to change these properties both for existing SmartDrawings 
and newly added ones. 

Pressing the buttons below describes how each of the controls in the dialog works.

 Automatic

 Preferred Size

 Grow

 Enter Text

 Image

 Colors

 Image Name



SmartDrawing Libraries
SmartDrawing Libraries are usually collections of symbols that are used by a particular type
of diagram. SmartDraw has dozens of libraries with symbols for flow charts, computer 
networks, space planning, clip art, and many more. 

Opening a New SmartDrawing Window
SmartDraw allows you to open up to 16 SmartDrawing Windows at the same time. Those 
that were open the last time that you closed the last drawing, or quit the program are 
automatically re-opened (in their previous positions) when you open your first drawing. You 
may open a library by selecting the Open SmartDrawing Library command in the 
Libraries menu. This presents the Open SmartDrawing Library dialog.

Minimizing Library Windows
You can minimize a SmartDrawings window by clicking on the minimize button in the top 
right hand corner. This changes the window to an icon that floats in front of your drawing. 
Double-clicking on the icon opens up the window again. This feature is useful if you have 
limited screen space and want to temporarily hide a SmartDrawing window.

Creating a New Library
You can create your own SmartDrawing Libraries, and add new shapes to existing libraries.

Editing an Existing SmartDrawing
You can change the parameters (but not the picture) of an existing drawing. To do this 
double click on its button, or select the button and then select the Edit Drawing command
in the menu. This presents the Edit SmartDrawing dialog.

Removing a Drawing from the Library
To remove a drawing from a library, click on its button and select the Remove Drawing 
command in the menu. To change the picture of a SmartDrawing, you must remove it and 
then add a new copy.

Changing the Size of the Buttons
Each SmartDrawing in a library is shown on its own button in the SmartDrawing Window. 
For complex SmartDrawings, it is sometimes hard to recognize the image if the button is 
too small. You can overcome this by changing the size of the buttons using the three 
commands show towards the bottom of the SmartDrawing Menu: Small Buttons, Medium
Buttons, and Large Buttons. Select the button size that best suits your library and 
display.

Symbol Names
Each symbol in a library may be assigned an optional name using the Edit SmartDrawing 
dialog. This is the name that shows in the ToolTip when the cursor is moved over the 
symbol in the SmartDrawing window. It is also the name that is shown when the Names 
command is used to change the buttons in the SmartDrawing window to show the names 
you assign to each SmartDrawing instead of their picture.



The naming feature is useful when more detail is required than an image might show. For 
example, an IBM PS/2 computer may appear to be similar to another PC when looking at 
the thumbnail image shown on the SmartDrawing buttons. Their names are quite different 
however, and showing the names in a ToolTip makes them easily distinguishable.

Names are also used when searching for a symbol by word. Additional keywords to be 
matched in searches may be entered following the name and a semi colon, separated by a 
space. Words after the semi colon are not displayed in the ToolTip, or when names are 
shown on the buttons.

Sharing Libraries
Libraries can be shared by multiple users on a network, or by multiple document toolbars 
used by the same user. When a library is opened more than once, the second and later 
clients open the library as read-only. Only the first client to open the library has write 
permission. Read-only libraries cannot be edited, and symbols cannot be added or 
removed.



Creating Your Own Objects
Joining Lines to Make a New Shape
You can create a new shape by joining together any collection of lines and curves that form 
a closed loop, using the Join to Make a New Shape command, under the Line menu. 

The new shape created is like any other: It can be filled. It can be rotated and you can type 
text into it.    You can also drop it on a SmartDrawing Window or Document Toolbar to 
create new SmartDrawing symbol. Shapes created this way are called Polygon Shapes. 
They have continuous connect points, and text editing areas that are assigned 
automatically. If the lines do not quite touch each other to form a closed loop, the Join 
command will fail.

Changing Existing Shapes
Any of the 24 built-in SmartDraw shapes, and Polygon Shapes made by joining lines, can 
be split apart into their component lines and curves using the Edit Shape Outline 
command under the Shapes menu. This is the reverse of the Join command above.

Once separated into lines and curves, the outline of the shape can be adjusted and then re-
combined into a re-designed shape.

Grouping
You can combine shapes and lines into new grouped objects, using the Group command.



Adjusting Shapes
The outline of many of the standard toolbar shapes can be adjusted. The degree of 
roundness of rounded rectangles, the angle between the vertical and horizontal sides of a 
parallelogram are all potentially variable. The defaults for these quantities can be adjusted 
when editing the toolbar. The outlines of objects already in the drawing can be also be 
adjusted by clicking on their Adjustment Handles.

To adjust the outline of an adjustable shape, click and drag on the open diamond-shaped 
handle that appears when an adjustable shape is selected. You can see the effect of the 
changes you are making in real time as shown by a temporary dotted image. Release the 
mouse and the shape changes its outline to match the dotted image.



Grouping
The Group command under the Draw menu combines selected objects into an Object 
Group. The Ungroup command reverses the effect of the Group command. Grouping 
objects that are already in a group with other objects simply combines them all into a 
single group. There is no hierarchy of groups.

Object groups behave as a single object in some respects, and as individual objects in 
others. 

The following operations treat a group as a single object.
- Clicking on any member of the group selects the group.
- Changing properties (color, thickness, font etc.) affects all members of the group.
- Moving the group moves all members of the group.
- Sizing the group sizes all members of the group.
- Rotation rotates the group as if it were a single object.
- Flipping reflects the group as if it were a single object.
- Duplicating, copying and pasting applies to the group as a whole.

The following operations treat a group as a individual objects
- Lines link to individual objects within a group.
- Text is edited and entered independently for each object in the group.
- Drawings remain attached to individual group members after they are grouped.
- Shapes attach to connectors and other shapes as individual objects

You cannot attach a drawing to a group. You must first ungroup, attach it to a member and 
then re-group.

Grouping objects that are already in a group with other objects simply combines them all 
into a single group. There is no hierarchy of groups.

Creating Shapes with Multiple Text Entry Areas
Grouping can be used to create shapes with more than one text entry area, by combining 
two or more shapes together.

Because this group is composed to two separate rectangle objects, text can be entered 
independently in the top and bottom half. Both halves of the group will grow to maintain it 
symmetry as text is entered.

Adding Groups to SmartDrawing Libraries



A grouped object may be added to a SmartDrawing Library as a new symbol by simply 
dragging it onto a SmartDrawing window. Groups retain their properties as SmartDrawings, 
and are added as a grouped object when introduced into a drawing. 



Linking Lines and Shapes
SmartDraw lets you link objects together so that they stay connected when you move or 
re-size them.    
The most common case is a line linked to two shapes. Moving one of the shapes changes 
the size and shape of the line as shown below.

Creating a Link
When line linking is enabled, a line may be linked to a shape by moving one end over the 
border of the shape. This is done either by growing or moving the line using the mouse. 
When the end of the line approaches the shape's border, a series of round solid circles 
appear, indicating the points on the border that the line may link to. These are called 
connect points.    This is shown below.

The end of the line then snaps to the closest connect point and the mouse cursor becomes 
an "anchor". Releasing the mouse while in this state establishes a link between the line and
the shape.

Links can also be created when objects are first added to the drawing. If the "pencil" 
method is used to add a line, and the initial mouse click is inside the border of a shape, a 
link to this shape is immediately established with the beginning of the line. This is shown 
by the display of connect points for the shape that was initially clicked upon. The end of the
line that follows the mouse can also be linked to a second object by dragging it to its 
border. Hence the linking of two shapes with a newly created line can be achieved in one 
drawing operation.

Breaking a Link
Links may be broken using the reverse of the link creation process. The end of the line is 
moved away from the border of the object using the mouse. Deleting either object also 
breaks the link.

Targets and Linked Objects
In any link relationship, the object that displays the connect points is the Linked Target, 
and the object linking to it is called the Linked Object. The linked target usually controls 
the positioning of the linked object. If the target is moved, the linked object either moves, 
or re-sizes to maintain the link.

Lines are allowed to have one or two linked targets. With one target, lines move when their 
target moves. With two, they change shape and/or re-size when one of their targets move.

When a line that is linked to one target is moved, the link is broken. When a line that is 
linked to two objects is moved, all three are moved as a group.



Linked Lines and "kinks"
Sometimes the line connecting the shapes is not perfectly straight. The best way to avoid
this problem is to set the snap to grid feature so that the center of shapes snap to the 
grid. If the lines used to link the shapes are attached at the center of the sides of the 
shapes, the connecting lines will be perfectly straight. Note that the snap to grid in 
drawings created with versions 1.0 and 2.0 is NOT set this way. Go to the Define Rulers and
Grid command under the Edit menu to correct this.

Another way to correct this problem is by adjusting the shape positions with the arrow keys.
If you select a line or shape by clicking on it, you can adjust its position by 1 screen pixel 
up, down, left or right by typing the arrow keys on the keyboard. Use this feature to fine 
tune the position of objects without regard to the Snap-to Grid.

Turning Linking On and Off
The Draw menu had commands that turn linking off. This is very useful when you want to 
draw a finely detailed picture and you would like to prevent lines drawn close to shapes 
(and each other) from linking together. The Allow Lines to Link command toggles the 
ability of lines to link to other objects. The Allow Shapes to Link command toggles the 
ability of shapes to link to each other. This is off by default.

Linking Shapes to Other Shapes
When the Allow Shapes to Link item under the draw menu is checked, then one shape 
can be linked to another. Shapes can never link to lines where a line is the linked target. 
When shapes link, any one of the grow handles on the linked shape can snap to any one of 
the connect points on the target shape. Shapes can only link to one target at a time.

This feature is useful if you want to attach a background text object to a shape so that it 
follows the shape around when it is moved or re-sized.

Linking Lines to Other Lines
Lines can link to other lines as a linked target. This is useful for creating branched networks
of lines that remain attached when the targets change size or move.



Changing the View
All SmartDraw drawings may occupy an area of up to 50 inches square. Unless your 
drawing is very large, you work only with a small part of this total area, normally up in the 
top left corner. The commands: 200%, 150%, 100%, 75%, 50%, Fit to Page, Fit to 
Window, and Custom, shown under the View menu, control the scale used to display your
drawing in the drawing window. 100% is the scale used by most Windows programs to show
objects at their natural size. The other scales make objects look smaller or bigger than they
really are. You can also click in the background of the drawing with the right mouse 
button to change the view.

These scale factors have no effect on the size of shapes and lines when they are 
printed out.

The Fit to Window selection shows the whole 50 inches of the drawing in the document 
window. Since the size of a page for the currently selected printer is normally much smaller 
than this, to print a drawing of this size, SmartDraw must "tile" it and print pieces of the 
drawing area on more than one page. The boundaries of these tiles or pages are shown as 
dotted lines.

The Fit to Page selection scale the window so that at least one full page is showing. This 
view and 50% also show the page boundary lines.

The Custom selection presents the Set Window Scale Dialog. This allows you to set the 
scale to any values between 5% and 400%.

The toolbar shows two buttons that you may use to change the scale factor. Pressing on the
button on the left, with the minus sign in the magnifying glass, selects the next smallest 
view menu item. Pressing the button on the right selects the next largest view. 

As the view changes, SmartDraw attempts to keep all selected objects (or all objects if 
none are selected) visible. If this is not possible (because the window is too small), it 
attempts to center the selected group in the window.

You can specifically select an object to scale up and bring into view by holding down the 
Control and Shift keys at the same time. This changes the cursor to a magnifying glass.    
If the view is set to Fit to Window, or Fit to Page, the cursor has a plus sign in the 
middle, and clicking on an object sets the scale to 100% and brings the object into view 
directly under the cursor.

If the view is set to 50% or above, the cursor has a minus sign in the middle, and clicking 
selects the Fit to Window view. A quick way to inspect a particular object is to hold the 
shift and control keys down, click once to select Fit to Window view, find the object that you
want to inspect and click on it. This brings the object into view at 100%.

See Printing.



Rulers and Grids
Drawings may show rulers along their top and left edges. These normally show the 
dimensions that objects will be when printed out. A line an inch long next to the ruler 
should normally be an inch long when printed. 

The scale and size of the divisions on the rulers, and whether they are displayed or not, is 
controlled using the Set Rulers and Grids Dialog. 

The number of units for each major division on the ruler is set by entering a value for 
Show. Major divisions can either occur every inch or centimeter on the screen. This is set 
using the    Inch or cm radio buttons. If    the Show value is not a whole number, the major 
divisions are scaled to slightly more or less than an inch (cm) so that they are separated by
whole number of units. In this case, one major division on the screen is not one inch (cm) 
when printed out.

The actual units chosen using the drop down list do not change the appearance of the 
rulers, but do affect the units shown for lines with automatic dimensioning. 

The number of divisions per major division can also be set using radio buttons, with a 
choice of 8, 10, 12, or 16.

The rulers can be hidden by checking or unchecking the checkbox in the dialog. 

This dialog is also used to control the way shapes align to the snap-to grid. The default 
setting snaps the centers of shapes to the grid. This is important if line linking is used to 
connect shapes because it ensures that the lines connecting the centers of shapes remain 
perfectly horizontal or vertical.

The size of the ruler divisions controls the spacing of the Snaps, and the Visible Grid. The 
snaps are turned on and off with the Use Snaps command under the Draw menu. The grid 
is shown or hidden with the Show Grid command under the View menu.

The top-left corner, where the rulers cross, normally shows a digital display of the current 
position of the cursor in the units of the ruler.

Clicking in a ruler displays a temporary dotted line that follows the position of the cursor. 
This can be used to measure the positions of objects in the drawing. Clicking in the corner 
where the two rulers cross and dragging shows two of these lines forming a "cross hair" 
arrangement. When Snaps are turned on, these temporary lines snap to the ruler 
graduations.



This field is only visible if the shape selected for the button may be adjusted in some way. The 
parameter value represents a proportion of the width or height of the shape and is usually limited to a
range of 0.1 to 0.4, or sometimes less. The effect of the change can be seen in the preview window if 
you click on it or click in another field.
Changing the shape assigned to the button will change the adjustment to its default value for that 
shape.



A button shows the shape currently selected for this toolbar location. Pressing the button presents a 
menu of standard shapes. Selecting one changes the assignment of the button to the selected shape.



The width and height fields control the size of the shape associated with this button when one is 
created using a drag and drop operation. For circles, and other shapes that can only be sized 
proportionately, changing one value changes the other, so as to maintain the same proportions.



Editing the Toolbar
The buttons on the toolbar that show shapes can be configured to show any of the 24 
standard shapes using the Edit Toolbar Location dialog. 

To bring this into view, either double-click on the button that you want to edit, or select the 
button by clicking on it once and then select the Toolbar item under the Edit menu.

This dialog can also be used to set the size of the shape when it is added to the drawing 
using a drag and drop operation, as well as the "adjustment" parameter for certain shapes. 
The adjustment parameter controls the degree of roundness for rounded rectangles, how 
angled arrows are, etc. 

Changing these parameters has no effect on any existing shapes in your drawing. They 
affect only new shapes that you add later.

Press the buttons below for an explanation of the controls in the dialog:

 Preferred Size

 Select Shape

 Adjustment



SmartDraw will display hints for beginning users if this box is checked. These are dialogs that pop-
up automatically when you try to use certain features of the program for the first time. They attempt 
to explain what you are about to do and provide a direct route to more detailed help. 
Each hint will only appear once in each SmartDraw session. Hints can be switched off from any Hint 
dialog. We recommend that you leave the Hints switched on the first few times that you use the 
program.



When a new drawing is created using the New button on the toolbar, or automatically when the 
program starts up, SmartDraw can create one in one of three ways.
- It can create a new empty drawing with the normal defaults.
- It can look for the file "SMRTDRAW.SDT" and attempt to open it as a new untitled drawing, or 
template. SMRTDRAW.SDT must be stored in the same DOS directory as the program.
- It can present the Template Dialog allowing you to pick a template for the new drawing. [This is 
never called from the toolbar button]

You can use the SMRTDRAW.SDT template feature to control the default colors, styles and other 
drawing parameters for newly created empty drawings.
Make your choice by selecting the appropriate radio button.



When SmartDraw first starts up it can either show the Welcome dialog, create a new empty drawing,
or show the Open Dialog. Make your choice by clicking on the appropriate radio button.



Checking this box causes an attached drawing to open in the maximized state, rather than as an 
overlapped window.



At magnifications of 50% or below, the boundaries of the currently chosen page size are shown as 
dotted lines. Selecting the All Magnifications radio button causes these lines to be displayed in all 
magnifications.



For large drawings that have lots of complex symbols redrawing in the Fit to Window view can 
sometimes be time consuming. In these cases, you can increase redraw speed by choosing to draw 
only a rectangular frame instead of the whole image in this view, either always, or only when the 
symbol is small.



Options Dialog
The Options Dialog controls the way the program behaves when starting up and when a 
new drawing is created. Press the buttons below for an explanation of the controls in the 
dialog:

 Start Up

 New Drawing

 Page Lines

 Quick Previews

 Attach

 Hints



SmartDraw Templates
SmartDraw lets you save and re-open your own template files. A template file is exactly 
the same as a regular SmartDraw file, except that it has a file extension of SDT instead of
the normal SDR. 
All of the SmartDraw Templates that ship with SmartDraw are installed into file system 
directories (folders) inside the SmartDraw program folder. Each of these folders represents 
one of the template categories shown in the Template Dialog.. The template files 
themselves have a file extension of *.SDT and reside in the category folders. If you are 
experienced in the use of the file system you can create your own categories by adding 
new folders to the program folder and then saving template files into them. 

Opening
SmartDraw ships with a broad selection of templates that are displayed in the Template 
dialog , whenever the New command is used to create a new drawing. Selecting a 
template from this dialog creates a new drawing that is a copy of the template. Changes 
made to this copy do not affect the original.
 
Template can also be opened using the Open command. This presents the Open File dialog.
There are two choices of file type: SmartDraw File and SmartDraw Template. Choosing 
File opens a window with the same name as the file. Saving from this window updates the 
file. If Template is chosen however, an Untitled window is opened. Saving this file does not
update the original but instead prompts you for a new file name. Opening a template file is 
just like creating a new drawing, except that it contains whatever was stored in the 
template.

Creating Templates
Any drawing may be saved to a template using the Save As command, under the File 
menu. This presents the Save dialog . Again, there are the same two choices of file type. 
Choosing Template saves the drawing to a template file with file extension SDT.    Saving 
to a template does not rename the drawing to reflect the template name. The flag that 
indicates that changes have been made to the drawing is also not cleared, so that if you 
attempt to close the file, it will still prompt you to save changes.

Unless you create the new template file in one of the existing category folders within the 
program folder, it will not show using the Template dialog.

Empty Drawings
The Options Dialog allows you to specify that the template SMRTDRAW.SDT be opened each
time you create a new drawing. This can be used to control the initial settings of your new 
empty drawings, even if the template file SMRTDRAW.SDT contains no shapes or lines. 
If you like a particular color and shadow style , for example, you can create a new drawing, 
select the color scheme you prefer, and save it as SMRTDRAW.SDT. If you place this file in 
the program directory, each new drawing you create will start with this style.

Setting default fonts for a new drawing requires that you set them for one shape. To do this,
add a shape and type "hello" inside. Select the shape so that it shows selection handles. 



Use the Typeface command under the Text menu to change the font, size and style of the 
text in the shape. You can also change the text color if you want to. Now delete the shape 
by typing the backspace key (while it is still selected). Save this drawing as a template. 
When re-opened, its default font, size and style will be set to the values you selected using 
the Font dialog.



Cut, Copy and Paste
The Copy command transfers all or part of the drawing to the clipboard. Its behavior 
depends on what is selected.    

When nothing is selected, Copy copies a representation of the whole drawing to the 
clipboard (as a metafile).    This can be pasted into word processors and other applications. 
If an application supports Object Linking and Embedding (OLE) as a client, pasting the 
drawing into it creates an OLE link back to SmartDraw so that double-clicking on the 
pasted drawing will open it up in SmartDraw again.

When one or more shapes or lines are selected, Copy copies a drawing made up of just 
those shapes to the clipboard. It also copies the shapes and lines themselves so that they 
can be pasted into another SmartDraw drawing, or somewhere else in the same drawing. 
Copying is also used to combine selected shapes and lines into a new SmartDrawing.

The Clear command is only available when shapes or lines are selected. It removes 
(deletes) the selected objects from the drawing. 

Cut is a combination of Clear and Copy. It first copies any selected objects to the clipboard, 
and then deletes them.

Paste adds items currently on the clipboard to the drawing. If the clipboard contains 
shapes or lines copied from SmartDraw, these are added to the current drawing. If the 
clipboard contains one of the graphic formats supported by SmartDraw, a Picture Object is
added. SmartDraw does not support OLE as a client, only as a server.

When text is being edited, Copy, Cut and Paste act on the text only in the standard 
Windows way.



Duplicate
The Duplicate command makes a copy of the selected lines and shapes and adds them to 
the drawing offset by a small distance from the original objects. 

The duplicated objects are automatically selected so that they can be moved as a group 
(by holding down the Shift key). If the newly duplicated objects are moved with respect to 
their original copies, the new distance between the new set of objects and the original set 
is used as the offset for further duplications. This makes creating evenly spaced rows and 
columns of lines or shapes very easy. An example makes this clear.

The illustration below shows the steps involved in making a column of evenly spaced lines.



Object Linking and Embedding (OLE)
SmartDraw is an Object Linking and Embedding (OLE) Server. This is a feature that 
allows other Windows programs that support OLE to insert SmartDraw drawings directly 
into their own documents.

A program that allows users to insert OLE objects into their own documents are called OLE 
Clients. Examples are Windows Write, Microsoft Word, Excel, PowerPoint, Lotus 1,2,3 , 
WordPerfect and most other major applications. To understand the features of OLE more 
clearly we will use Microsoft Word as an example OLE Client application.

Embedding
Word, and other client programs, all have an Insert Object menu item. If you use this 
command, you are presented with a scrolling list showing the names of the OLE Server 
documents that are installed on your system. SmartDraw Drawing should appear in this 
list. If you make this selection, SmartDraw will be launched, or will come to the front, with 
a new empty drawing. Whatever you draw in this window will show as a picture in your 
Word document when you save the drawing. This is called Embedding.

The SmartDraw drawing seen in your Word document actually contains all the information
that would be stored inside a SmartDraw file. If you double-click on the drawing in Word, 
SmartDraw is launched again, and comes to the front showing the drawing you 
embedded. You can make changes to this drawing and save it back to Word again.

You can also embed a copy of a SmartDraw drawing in Word (and other clients) by 
copying the drawing from SmartDraw, and pasting it into Word. The copied picture 
appears in your Word document. Double-clicking on this picture launches SmartDraw and 
you can make changes to the picture again.

Linking
The second type of behavior supported by OLE is Linking. Linking occurs between a client 
like Microsoft Word and an existing SmartDraw file. A link is established with SmartDraw 
drawing by using the Paste Special, (or Paste Link) command, that appears under the 
Edit menu, in Word and other clients.

Pasting a link is only possible if a copy occurred from a SmartDraw drawing that has a real
file name. Copying from an Untitled drawing will not allow a Paste Link.

When a link is pasted, the drawing appears in the Word document, just as it does with 
embedding (normal pasting). However, the drawing you see is an image of the entire 
SmartDraw file, not just the part that you copied. Any changes you make in the 
SmartDraw file are reflected inside the Word document the next time you open it. Two or 
more Word documents can be linked to the same SmartDraw file, and are automatically 
updated when changes are made to it.

Drag and Drop
You can embed SmartDraw objects in a client using drag and drop. Simply select the 
objects that you want to embed and, instead of copying them, simply move them to Word, 



or your client program, by dragging. Do this is exactly the same way that you would move 
a group of objects from one part of the SmartDraw drawing area to another. Unless you 
hold the Ctrl key down while you do this, the objects will be removed from the SmartDraw 
drawing. If you hold down the Ctrl key the objects will be copied, rather than moved.

SmartDraw is an OLE 2.0 Server. It not an OLE Client.



Some Metafiles are not Supported
SmartDraw will not import or paste certain metafiles that contain rarely used obsolete 
instructions. If you encounter this message, please contact us at mail@smartdraw.com and 
send us a copy of the metafile that will not import.



Importing Pictures
Pictures from other programs, saved as disk files, can be imported into SmartDraw 
drawings via the Import Dialog. The name of the file that contains the picture to be 
imported is selected using the dialog controls in the same way as the Open Dialog.

The Files of Type control changes the extension of the files shown in the File Name list.    
SmartDraw automatically detects the type of graphic file it is trying to import and the 
selection of the extension has no effect on the type of file that SmartDraw expects to find.
SmartDraw supports import and export of files in Windows Metafile, and several 
bitmapped formats, including, BMP, PC PaintBrush (PCX), GIF, JPEG and TIFF. GIF files can be
exported with a transparent background for use with World Wide Web pages.

Once imported, pictures become Picture Objects and behave like rectangle shapes. Pictures
from other programs can also be imported via the Paste command.



Exporting
Drawings can be exported (saved) in standard Windows file formats via the Export Dialog. 
The name of the file to export to is specified using the dialog controls in the same way as 
the Save Dialog.

The Save As Type control changes the format of the exported file. SmartDraw supports 
import and export of files in Windows Metafile, and several bitmapped formats, including, 
BMP, PC PaintBrush (PCX), GIF, JPEG and TIFF. GIF files can be exported with a transparent 
background for use with World Wide Web pages.

SmartDraw drawings can also be exported to other applications via the Copy command 
and OLE.



Send
The Windows 95 version of SmartDraw supports the standard Send command found on the
file menu. This sends your current document, or all open documents, to an email address 
embedded in an email message.



Exporting to Web Pages
SmartDraw supports both of the standard image formats used in pages for the World Wide 
Web (WWW): JPEG and GIF.

When exporting to GIF you can specify a background color that will appear to be 
transparent when viewed with most web browsers, and whether the exported file should be
in interlaced or non-interlaced format. Interlaced images display more quickly than non-
interlaced, but take longer to come into focus. These options are specified in the GIF 
Format Options Dialog. This is displayed automatically each time a file is exported in GIF
format.

Note that the transparent option may not work correctly if your system is using more than 
256 colors.



Picture Objects
When pictures from other programs are imported or pasted into SmartDraw they become 
Picture Objects. These can be thought of as rectangle shapes, initially with no border, 
with the picture inside.

Picture objects can be moved and arranged like any other object. Normally they may only 
be sized so as to maintain their proportions, however, if you hold down the Shift key while 
you drag with the mouse, you can size them to any proportion.

You can change the    way pictures change size using the Shape Sizing dialog. To bring this 
into view, select the picture and then select the Pictures menu item under the Shapes 
menu.

Unlike shapes, when you try an enter text inside a picture object, it goes underneath 
instead of inside. Text underneath (or above) pictures and SmartDrawings may be selected 
separately and assigned borders and other attributes.

Pictures may be given borders using the Shape menu, but not fill colors.



The Print Quality controls the number of dots per inch (the resolution) that the printer will use to 
represent the page being printed. The higher the quality the more memory your printer may need to 
print the drawing.



For printers that do not have enough memory to store a whole page (like dot matrix printers) this is 
often checked and made inactive.
Checking the box will cause multiple copies of a drawing that does not fit on one page to be printed 
so that the pages are in collated order: page 1, 2, 3...., followed by    page 1, 2, 3.... and so on.
Unchecking the box, will cause all copies of page 1 to be printed, followed by all copies of page 2 and 
so on. Non-collated printing (where available) is often faster than collated printing.



Checking this box causes the entire drawing to be printed on a single page. This is achieved by 
scaling the image down to fit on the page and may result in reduced legibility.



Checking this causes the drawing to be printed in black and white only. All borders, lines and text are 
made black, and the background and shape fills are made white. This often gives sharper results with 
non-color printers, and requires much less printer memory than printing in color.



Pressing this button brings the Define Footer dialog into view. This lets you control the position and 
font of the page footers.



Checking this causes a footer showing the number of the page to be printed at the bottom of each 
page. You can control the font and position of this footer by pressing the Define Footer button.



This causes the printed image to be stored in a file on disk instead of being printed to the printer. This
is useful for making Postscript files to send to a service bureau when using a Postscript driver.



This sets the number of copies that you want to print.



Controls the range of pages that will print. Only the rectangular array of pages that contain part of 
the drawing are printed, beginning with the top left and continuing across the top row, to the second 
row and so on. There are three choices:
All means all pages containing the drawing are printed
Selection means print only objects that are Selected .
Pages allows the entry of a specific range of pages, with page 1 being the top-left as described 
above.



Define Footer Dialog
The Define Footer Dialog allows you to control the placement of footers at the bottom of 
each printed page. A footer shows the name of the drawing, the page number and the 
current date and time combined into a string.

The dialog is accessed from the Print Dialog via the Define Footer button. This becomes 
visible when the checkbox labeled Print Page Footers is checked.

There are two sets of controls: Using the Position radio buttons, you can position the 
footer at the very bottom of the printable area of the page, or 1/4 inch or 1/2 inch above 
the bottom. 

Pressing the Font button displays the Windows Font Dialog. This lets you choose the font,
size and style for the footer text. A point size of 10 or less is recommended.



Print Dialog
The Print Dialog controls the way a drawing is printed. 

The current target printer is shown at the top of the dialog. This can be changed by 
pressing the Setup button. Setup presents the Printer Setup Dialog.

 Print Range

 Print Quality

 Copies

 Collate

 Print To File

 Print Page Footers

 Print No Color

 Print on One Page

 Define Footer



Printing

The Print command under the File Menu is used to print a drawing. This presents the Print 
Dialog. Pressing OK at this dialog begins printing.

The largest drawing supported is 50 inches square. In the Fit to Window view, the 
boundaries of the pages over the whole area of the drawing are shown as dotted lines. If a 
drawing is larger than one page, the rectangular array of pages that the drawing touches 
will be printed. This is shown below

In the example above, four pages will be printed, marked 1,2,3, and 4. The most top-left of 
the pages that contain the drawing is printed as page 1. The remaining pages are then 
printed, starting with the next page in the same row as page 2, and then forward to the 
bottom right across each row.

When a page range is specified in the Print Dialog, the page numbering follows this 
scheme. For example, to print the bottom right page only, in the case shown in the picture 
above, a range of page 4 through 4 is specified.

The Printer Setup Dialog is used to set the target printer, the page orientation and other 
printer-specific parameters. This information is stored with the drawing. If you choose a 
specific printer (i.e. not the default printer) for a drawing, the next time you print it, it will 
automatically select the same printer, no matter what the setting for the default printer is.

You can also choose to print with 1/6" overlap between each page of a multi-page drawing. 
This causes a small strip of each page to be repeated on the pages that surround it. This 
makes pasting together large drawings easier.



Checking this box causes a small strip of each page to be repeated on the pages that surround it. This
makes pasting together large drawings easier.



Select the paper size from the list.



Choose either landscape or portrait, as shown by the icon.



Selecting the Default Printer will cause this drawing to print to whatever the default printer (set 
using the Control Panel) is set to. 
Selecting a Specific Printer will cause this drawing to print to the chosen printer, no matter what 
the default printer is set to.



Print Preview
The Print Preview command enters Print Preview mode. 

The Print Preview button on toolbar can also be used as a shortcut for this command.

In print preview mode, the program window shows a representation of a printed page. For 
drawings that require more than one page to print, the scrollbar on the right controls which 
page is previewed. The current page number is shown at the top left of the toolbar. The 
toolbar also has three buttons: Close, which ends the preview mode, Print, which ends the
preview and presents the Print dialog , and a Help button.

Note that if the last time that you printed, you selected Print on One Page, the preview will 
show the whole drawing printed on one page.



Printer Setup
This dialog is used to set the target printer, the page orientation (landscape or portrait) and
other printer-specific parameters. This information is stored with the drawing. If you choose
a specific printer (i.e. not the default printer) for a drawing, the next time you print it, it will 
automatically select the same printer, no matter what the default printer setting is.

 Printer

 Orientation

 Paper

 Overlap



SmartDraw Menu Commands
File Menu
Edit Menu
View Menu
Shape Menu
Line Menu
Text Menu
Draw Menu
Libraries Menu 
Window Menu

To get help on a particular menu item, press Shift-F1, or press the help button on the 
toolbar, and then pull down on the menu item. To get help on a tool bar button, Press Shift-
F1 and click on the button.



File Menu
New 
Creates a new drawing.

Open
Opens an existing drawing file.

Close
Closes the current drawing window

Save
Saves the current drawing to the same file.

Save As...
Saves the current drawing to a different file.

Printer Setup
Presents the standard Printer Setup Dialog.

Print Preview
Enter Print Preview mode.

Print
Prints the drawing.

Print Order Form (Trial Edition Only)
Prints the order form for Registration.

Export
Exports the current drawing in a graphic format that can be read by other programs.

Import
Imports pictures from other graphic programs.

Send
Presents the Send Mail dialog. This menu item is only visible on mail-enabled systems.

Exit
Exits the program.

File Names



The up to four file names at the bottom of the file are the names of the most recently used 
files. Selecting one of these opens that file or brings it to the front.



Edit Menu
Undo
Undoes or re-does the last operation.

Cut
Copies the current selection to the clipboard and then deletes it.

Copy
Copies the current selection to the clipboard.

Paste
Pastes the current contents of the clipboard into the drawing

Clear
Removes the currently selected shapes and lines

Select All
Selects all lines and shapes in the drawing.

Duplicate 
Makes a copy of the currently selected objects

Colors and Shadows
Selects a new color and shadow style for the drawing.

Toolbar
Edits a shape button on the toolbar.

Options
Presents the Options Dialog.



View Menu
Fit to Window
Displays the whole drawing area in the window.

Fit to Page
Displays the drawing scaled so that at least one page shows in the window.

50%
Displays the drawing scaled to 50 % of its normal size.

75%
Displays the drawing scaled to 75% of its normal size.

100%
Displays the drawing at normal size.

150%
Displays the drawing scaled to 150% of its normal size.

200%
Displays the drawing scaled to 200% of its normal size.

Custom
Displays the Set Window Scale dialog.

Background Color
Changes the color of the drawing background.

Show Toolbar
Shows or hides the Toolbar.

Define Rulers and Grid
Displays the Rulers and Grids Dialog.

Show Grid
Shows or hides the visible grid.



Line Menu
Style
Controls the thickness and pattern of lines.

Color
Controls the color of lines.

Change Line Shape/Change Connector Shape
Changes the shape of lines and connectors.

Arrowheads
Presents the Arrowhead Dialog, that allows you to add arrowheads to lines and curves.

Show Length
Causes the line to show its length using the ruler scale.

Join To Make a New Shape
Combines lines and curves into a new fillable shape.

Align Text on the Line
Controls whether text attached to a line follows the direction of the line.



Text Menu
Typeface
This presents the Font Dialog, for selecting the typeface of selected shapes and text.

Color
Controls the color of selected text, or all text in selected shapes.

Alignment
Controls the horizontal and vertical position of text inside a shape or on a line.

Insert Symbol
Present the Insert Symbol Dialog.

Bullets
Changes the text format to show bullets with each paragraph.

Shadow
Hides or shows the current text shadow for individual objects.



Draw Menu
Align
Aligns selected objects with the target object.

Make Same Size
Makes selected objects the same size as the target object.

Space Evenly
Arranges a collection of objects so that they are spaced apart by an equal distance.

Flip
Reflects the shape or line about a horizontal or vertical axis through its center.

Rotate
Rotates shapes and lines.

Center Drawing on Page
Centers the entire drawing on the page.

Group
Combines the selected object into a group that behaves like a single object.

Ungroup
Breaks a group up into its component objects.

Bring to Front
Brings selected objects in front of un-selected objects.

Send to Back
Sends selected objects behind un-selected objects.

Hide Shadow
Hides or shows the current shadow for individual lines and shapes.

Lock Object
Locking prevents objects from being accidentally moved or edited. This command turns 
locking on and off.

Attach



The commands on this sub menu associate other files with an object.

Use Snaps

Turns the snap mechanism on and off.

Allow Lines to Link

Turns on and off the ability for lines to link to other objects.

Allow Shapes to Link.

Turns on and off the ability for shapes to link to other objects.



Libraries Menu
Open SmartDrawing Library
Presents the Open SmartDrawing Library dialog.

Create New Library
Creates a new (empty) SmartDrawing library and opens it.

Close Library
Closes the front SmartDrawing library and window.

Edit Drawing
Presents the Edit SmartDrawing dialog for currently selected drawing.

Add New Drawing
Allows the addition of any windows metafile currently on the clipboard to the library as a 
new SmartDrawing.

Remove Drawing
Removes the currently selected SmartDrawing from the library.

Small Buttons, Medium Buttons and Large Buttons
Controls the button size in the window.

Name
Shows the name of the SmartDrawing on the button instead of its picture.

The remaining items on the menu list the recently opened libraries. Selecting one of these 
items either opens the library or brings its window to the front.



The Window Menu
The Window menu lets you arrange any open drawing windows, or bring one to the front.

Cascade Windows arranges them to overlap each other, offset from the top left hand 
corner of the program window. 

Tile Windows arranges them to fill the program window as non-overlapping tiles.    

The remaining items on the menu list the open windows. Selecting one of these items 
brings its window to the front.



Connecting to the Web
The Browse SmartDraw Web Page and Get Technical Support commands connect 
your web browser to our web site. These commands may not work if your browser does not 
follow the Windows standard for registration.



Technical Support
SmartDraw Software Inc. provides technical support under the following terms and 
conditions:

Registered Users
Up to 30 minutes of support is provided at no charge for the first 90 days following 
registration.    Please have your registration number ready. This is shown clearly on your 
sales invoice if you purchased directly from SmartDraw Software. 

After this date you may call with a credit card and obtain support at the rate of $7.50 per    
5 minutes. There is no charge for hold time, and no charge if the problem is identified as a 
"bug" in SmartDraw.    Whether the problem qualifies as a bug is at the sole discretion of 
SmartDraw Software Inc.

If a user reports a    bug that prevents proper use of the program during the first 90 days 
following registration, SmartDraw Software will either fix the bug, or offer a complete 
refund.

Non Registered Users
You may call for technical support with a credit card and obtain support at the rate of $7.50
per    5 minutes. There is no charge for hold time, and no charge if the problem is identified 
as a "bug" in SmartDraw.    Whether the problem qualifies as a bug is at the sole discretion 
of SmartDraw Software Inc.

You may also register over the phone with a credit card and obtain technical support at no 
charge under the terms of    Registered Users described above.

Suggestions
We invite suggestions. There is never any charge for suggestions. Please contact us.

Using the Web
Please visit our World Wide Web site. Here you will find news of the latest releases, patches,
tips and useful information. If your web browser is installed in the right (Microsoft) way, you
can connect by simply selecting the Browse SmartDraw Web Page command, under the 
Help menu. 

Getting Support
The best way to do this is via electronic mail. Depending on how simple your problem is, 
you may get e-mail support with no charge. Our email address is:

support@smartdraw.com

E-mail from Compuserve, AOL, or the Internet should reach us at this address.    You can 
also call us at (619) 549 0314.



When reporting a problem, please include the following information:
1) Your system configuration (version of Windows, printer, display type etc.)
2) A description of how to reproduce the problem.
3) A sample file that exhibits the problem (if possible).
See Troubleshooting.



Troubleshooting
Problems
If you experience problems (non-euphemistically known as bugs!) using SmartDraw 
please report them. The best way to do this is via electronic mail. Our email address is:

support@smartdraw.com

Email from Compuserve, AOL, or the Internet should reach us at this address. You can also 
call us at (619) 549 0314.

When reporting a problem, please include the following information:

1) Your system configuration (version of Windows, printer, display type etc.)
2) A description of how to reproduce the problem.
3) A sample file that exhibits the problem (if possible).

Solutions
To get instant information about the most common user problems, use the Get Technical 
Support command under the Help menu to connect to our technical support web pages.
Below are some answers to common problems. 

GPF
SmartDraw should never crash with a GPF. If this happens under Windows 95, there are two
things to check:

1. Adobe Type Manager.
If the Details of the GPF show that it occurred in the module ATM32.DLL, then the problem
is caused by a bug in the Adobe Type Manager (ATM). This is a piece of software supplied 
by Adobe Systems that has been installed on your system by some other program. It is 
started automatically each time your system starts.

SmartDraw makes a legitimate Windows call that causes older versions of ATM to GPF. The 
solution is either to (a) remove ATM from your system. [It is not particularly useful since 
Windows now includes scaleable fonts], or (b) get an up-to-date version of ATM from Adobe.

2. Graphics Acceleration Setting
Some graphics controller boards use some hardware optimizations in attempt to speed up 
common graphics operations. Leaving these features turned on can cause graphic-intensive
applications like SmartDraw to fail. To turn these optimizations off go the Windows 95 
Control Panel and open the System icon. Go to the Performance tab and press the Graphics 
button. Move the slider control all the way to the left, to turn off graphics acceleration. Now
press OK and restart your application.

If the GPF persists, please report it to support@smartdraw.com.



Printing
This is by far the most common area for problems. Many of these issues are caused by 
buggy printer drivers. If you encounter a printing problem, the first thing to do is to try the 
latest version of the printer driver. You can get these for HP printers from the HP forum 
under Compuserve, in the Windows Software area under America Online (Look in 
Drivers/Printers), or by calling Microsoft at 1-800-426-9400). Here are some of the more 
common printer problems.

Q. My printer gives an out of memory error each time I try to print my drawing.
A. This is most commonly caused when you try to print a drawing that has a non-white 
background color, and you are printing with Print No Color box un-checked. This causes 
some printer drivers to send a full-page bitmap to the printer. Many LaserJet printers, in 
particular, do not come from the factory with enough memory to handle this. The solution 
is to change the background color to white, or to check the Print No Color box. Checking the
box will cause your drawing to print in pure black and white colors.

Q. My sideways text is not sideways when I print.
A. Not all printer drivers support sideways text. Many that say they do, do not work 
properly. For LaserJet drivers that have this problem, checking the Print True Type fonts 
as Graphics box in the driver may help. Getting the latest version of the driver may also 
help. (Look on Compuserve or AOL). 

Switching fonts may also work. Sometimes True Type fonts are substituted by printer fonts 
at print time. These printer fonts may not support rotation. Substitutions of this kind are 
found in the WIN.INI file.

Q. My drawing looks completely wrong when I print it.
A. Some earlier versions of HP LaserJet printer drivers for Windows are not very reliable. If 
your print-out has text in the wrong place, or lines and shapes are jumbled up, try installing
the latest printer driver for your printer. For HP printers, you can get these from HP's forum 
on Compuserve. 
Q. I get no text when I print.
A. Check your system resources. If they are below 50%, re-start Windows and try printing 
again.

OLE and Copying
Q. Pictures from SmartDraw get scrambled when I paste them into other applications.
A. Most applications pick Windows metafiles apart when they are pasted into one of their 
documents. The Microsoft Office applications seem to do an excellent job of this. Other 
applications are not so capable. Corel Draw seems to have a problem with certain 
metafiles. There is not much you can do about this, but please report it so that we can work
with the vendor to try and fix the problem.
If you have this problem in WordPerfect, get WP 6.1 or later. If you are printing to a LaserJet
use the Microsoft printer driver, not the WP driver.

Q. When I paste a picture from SmartDraw into another application and double-click on it, 
SmartDraw is not launched. I thought SmartDraw supported OLE.



A. For OLE to work, the application you paste a SmartDraw picture into must be an OLE 
Client. OLE Clients usually have an Insert Object menu command.

SmartDrawings
Q. The SmartDrawing I added does not change color like other shapes.
A. Before this can happen you must check the Change colors box in the Edit SmartDrawing 
dialog. Even if this is checked, colors may not change as you expect. Bitmapped drawings 
in particular may not change color.

The rules are: All pens used follow the border style and color. Black fills follow the border 
color. Text color follows the border color. Non-black fills follow the Fill color. Transparent fills 
used by the drawing are left alone.



Large SmartDrawings are not a good idea
The Windows metafile that you are attempting to add to the SmartDrawing library exceeds 
1,000,000 bytes. Metafiles of this size do not make good SmartDrawings.

Metafiles that are this large are usually very complex line drawings, or bitmaps. 
SmartDrawings are better when they are small and simple line drawings. Very complex 
drawings are slow and cumbersome. Bitmaps do not scale or print well at high resolution.

Try a simpler version of your image.



Press this button to add new styles, or change the settings for existing styles.



Creates a new drawing or library.



Shows the list of styles to choose from.



SmartDraw Trial Version Software License Agreement

Grant of License
This SmartDraw license agreement grants you a non-exclusive right to load and use the 
SmartDraw Software Trial Version 3 (the "Software") for a period of 30 days from the date 
that the software was first loaded on one or more computers. Once the 30 day period has 
expired, you (the licensee) agree to either purchase a permanent license to use the 
software, or to destroy the Software and all copies in your possession.

The software is "loaded" onto a computer when it is either copied to the permanent 
memory of the computer (the hard disk) or loaded into the temporary memory (RAM), such 
as when a computer runs the software from a network server, or a floppy disk.

Single vs. Multiple Use
You may use the software only on a single computer, or on up to two computers used exclusively by the 
same individual user, unless otherwise specified in a receipt for a multiple-use license.

If a multiple-use license is purchased, the software may only be used on more than one computer, at the
same site, or connected to the same network, provided that the number of computers that have either 
direct or networked access to the software do not exceed the number specified in the receipt for the 
multiple use license. For example, if a license for use on 100 computers is purchased, the software 
cannot be installed such that more than 100 computers may load it.

Copyright
The Software is owned by SmartDraw Software Inc. and is protected by United States 
copyright laws and international treaty provisions. You must treat the software like any 
other copyrighted material ( for example, a book), except that you may make a copy for the
purposes of loading it onto the hard disk of the computers that are licensed under this 
agreement.

Other Restrictions
You may not transfer your rights under this agreement. You must not rent or lease this 
software. You may not decompile or disassemble the Software. You may not distribute the 
Software as part of any of any other software, or collection of software without the written 
agreement of SmartDraw Software Inc.

LIMITED WARRANTY AND DISCLAIMER OF WARRANTY 
THIS SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS (INCLUDING INSTRUCTIONS 
FOR USE) ARE PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND. FURTHER, 
SMARTDRAW SOFTWARE INC. DOES NOT WARRANT, GUARANTEE, OR MAKE ANY 
REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF USE, OF THE SOFTWARE OR 
WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS,
OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE 
SOFTWARE IS ASSUMED BY YOU. 
IF THE SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE YOU, AND NOT 
SMARTDRAW SOFTWARE INC. OR ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, 
ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.
 
THE ABOVE IS THE ONLY WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE, THAT IS MADE BY SMARTDRAW SOFTWARE INC., ON 
THIS SMARTDRAW SOFTWARE INC. PRODUCT. NO ORAL OR WRITTEN INFORMATION OR 
ADVICE GIVEN BY SMARTDRAW SOFTWARE INC., ITS DEALERS, DISTRIBUTORS, AGENTS OR 



EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS 
WARRANTY AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. YOU MAY 
HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE.
 
NEITHER SMARTDRAW SOFTWARE INC. NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE
CREATION, PRODUCTION OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY 
DIRECT, INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR 
LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, 
AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE SUCH PRODUCT EVEN IF 
SMARTDRAW SOFTWARE INC. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.



How to Order SmartDraw
On-line
You may purchase SmartDraw on-line on the web (Internet) at http://www.smartdraw.com. Delivery 
can be immediate via download directly to your PC, or later with physical media (CD, disks and 
Manuals) shipped to you, or BOTH! 

Choosing electronic delivery directly to your PC saves both time and shipping charges. You can also 
download an electronic copy of the printed documentation, that you can print out. On-line ordering is by 
credit card only. Visit our web site for details. 

By Phone or Fax
Call 1 800 501 0314 within the US and Canada, or call (619) 549 0314, outside the US, 24 hours per 
day, 7 days per week, to order. Or  Fax Us at 619 549 2830. Your order will be shipped within one 
business day.

Use the Order Form
Double-click on your country below and the correct order form will show in this Help window. Print it out 
using the Print Topic command under the File menu shown in the Help window. Then mail, fax or call 
the address shown on the form.

USA, Canada and all others           SmartDraw Software  
Australia                                            Dunson P/L  
België                                                 CopyCats  
Deutschland                                     CopyCats  
France                                               WindowShare  
Italia                                                   Bertone  
Japan                                                 P & A  
Korea                                                 ASC Co  
Nederland                                         CopyCats  
UK                                                     The Thompson Partnership  



SmartDraw Order Form (Individual Copies)    
[Print this form using the Print Topic command]

A Single User License that permits the use of SmartDraw on a single computer, or on up to two computers used exclusively by the 
same individual user.    Order individual copies (as many as you like) with this form.

Shipping Information
Name_________________________________    Company______________________________
Street________________________________________________________________________    
City__________________________ State_____ ZIP___________ Country________________
Phone ____________________ Fax _____________________ EMail____________________

Programs Ordered
SmartDraw ………………………………. Quantity _____ x $49.00(US)………… $_____
(Program includes both 16-bit Windows 3.1 and 32-bit Windows 95/NT versions of SmartDraw)

Add-on Templates and Libraries Ordered
Flyers and Fun Collection………… Quantity _____ x $19.00(US)………… $_____
Maps and International…………… Quantity _____ x $19.00(US)………… $_____

To Download the full program now and pay no shipping charges, please visit the SmartDraw 
Software web site at http://www.smartdraw.com.* Otherwise, you must SELECT ONE OF THE 
SHIPPING / MEDIA OPTIONS BELOW for delivery! (*On-line payment is by credit card only. Disks and
manuals are also available with on-line orders). 

Shipping / Media Options (please choose one)
Qty. (may not exceed the number of SmartDraw licenses ordered above)
____    CD only (with electronic manual)…($4.95 US & Canada, $6.95 International).. $_____
____    CD + Printed Manual…………..($8.95 US & Canada,    $12.95 International)……$_____
____    CD + 3.5-in. Disks + Printed Manual…($12.95 US & Can., $19.95 International)$_____

Sales tax (California Only)
Subtotal ………………………………. $_____
Calif. residents add 7.75% Sales tax $_____

GRAND TOTAL……………… $____
Payment Information
Payment Method:    ___    Credit Card        ___ US Check      ___ Purchase Order [Fax the P.O.]
Credit Card Information. (Visa ,MasterCard and American Express). 
Number: __ __ __ __    __ __ __ __    __ __ __ __    __ __ __ __      
Name:          __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __    _
Expires    __ __    / __ __      Signature_______________________

How to Order
+Mail this form and payment to: SmartDraw Software Inc., 

9974 Scripps Ranch Blvd, #35, San Diego, CA 92131, USA
+or, Fax the form, with credit card information filled in above, to (619) 549 2830
+or, call SmartDraw at 1-(800) 501 0314 [Outside US, or tech support, call (619) 549 0314.] 
+or, order on-line using the web: http://www.smartdraw.com
Prices good through December 1998

SmartDraw Site License Order Form    (For 10 or more users)
A Multiple User License (Site License) permits the use of SmartDraw on more than one computer used at the same site, or on the 
same network.    Visit the SmartDraw web site at http://www.smartdraw.com for more license information.
Shipping Information
Name_________________________________    Company______________________________



Street________________________________________________________________________    
City__________________________ State_____ ZIP___________ Country________________
Phone ____________________ Fax _____________________ EMail____________________

Products Ordered 
SmartDraw (Program includes both Windows 3.1 and Windows 95 versions)

10-24 Computers .................          No. of Computers  _____ x $35.00(US)... $_____
25-99 Computers .................          No. of Computers  _____ x $32.00(US)... $_____ 
100+ Computers ..................          No. of Computers  _____ x $28.00(US)... $_____

SmartDraw Flyers and Fun Collection
10-99 Computers ................. No. of Computers _____ x $14.00(US)... $_____
100+ Computers    ................. No. of Computers _____ x $10.00(US)... $_____

SmartDraw Maps and International Collection
10-99 Computers ................ No. of Computers_____ x $14.00(US)... $_____
100+ Computers    ................ No. of Computers _____ x $10.00(US)... $_____

To Download the full program now and pay no shipping charges, please visit the SmartDraw 
Software web site at http://www.smartdraw.com.* Otherwise, you must SELECT ONE OF THE 
SHIPPING / MEDIA OPTIONS BELOW for delivery! (*On-line payment is by credit card only. Disks and
manuals are also available with on-line orders).
Shipping / Media Options (please choose at least one)
Qty. (may not exceed the number of SmartDraw licenses ordered above)
____    CD only (with electronic manual)…($4.95 US & Canada, $6.95 International).. $_____
____    CD + Printed Manual…………..($8.95 US & Canada,    $12.95 International)……$_____
____    CD + 3.5-in. Disks + Printed Manual…($12.95 US & Can., $19.95 International)$_____

Sales tax (California Only)
Subtotal……………………… ………… $_____
Calif. residents add 7.75% Sales tax $_____
GRAND TOTAL………………… $____

Payment Information
Payment Method:    ___    Credit Card        ___ US Check      ___ Purchase Order [Fax the P.O.]
Credit Card Information. (Visa ,MasterCard and American Express). 
Number: __ __ __ __    __ __ __ __    __ __ __ __    __ __ __ __      
Name:          __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __    _
Expires    __ __    / __ __      Signature_______________________
How to Order
+Mail this form and payment to: SmartDraw Software Inc., 

9974 Scripps Ranch Blvd, #35, San Diego, CA 92131, USA
+or, Fax the form, with credit card information filled in below, to (619) 549 2830
+or, call SmartDraw at 1-(800) 501 0314 [Outside US, or tech support, call (619) 549 0314.] 
+or, order on-line using the web: http://www.smartdraw.com       * * Prices good through December 1998

SmartDraw Ordering Information

Best Business Program - SIAF, 1997
Best Business Program - Ziff Davis Awards (PC Magazine) 1996

 Best Graphics Program - SIAF 1995

Get two versions of SmartDraw for $49
SmartDraw is available in both Windows 95 and Windows 3.1 Editions. When you order SmartDraw, 
you automatically receive BOTH versions. This is ideal if you are still using Windows 3.1 but plan to 



upgrade to Windows 95 or NT 4.0 later.

Order SmartDraw for just $49.00, and here's what you get:
· Full versions of BOTH the Win 3.1 and Win 95 program with no time limit
· Electronic Manual    included free on the CD-ROM, or when you buy on-line
· More than 1500 symbols and templates
· 90 days of free technical support
· Notices of free updates, major upgrades, and additional offers

Optional Printed Manual
· If you choose, you can also order the optional, 120-page printed manual, with index and 

table of contents.    (The electronic manual, included free on the CD-ROM or when you buy on-
line, is identical to the printed Manual, and can be printed out on standard 8.5 x 11 or A4 paper.)

If your time limit has expired! Place an order and we will reset your trial for 
another 30 days while you wait for delivery. 

SmartDraw Add-on Templates and Libraries
SmartDraw Flyers and Fun Collection
The SmartDraw Flyers and Fun Collection contains more than 150 templates and clip-art images 
designed for making flyers, posters, signs, invitations, certificates and more. It has great-looking layouts 
for major holidays, celebrations and things you can use at the office. Kids will love it, too. With the Flyers
and Fun Collection you can use SmartDraw for all your drawing needs. The Flyers and Fun Collection 
is only $19.00 and REQUIRES SmartDraw 3.0 or higher.

SmartDraw Maps and International Collection
The Maps and International Collection contains more than 500 symbols and templates covering maps of
the USA and the whole world, plus the flags of 136 countries. 
The maps of individual countries (and US States) fit together to form a complete map of their entire 
region. This means you can create you own regional maps, or you can use those already assembled as 
templates. 
US Templates include The US by region (North East, Mid-West, Pacific etc.), by congressional district, 
by zip code, and the counties of each state. World templates include major regions of the world, 
including SE Asia, Central Asia, Central Europe, Russia, Middle East etc. You can color and manipulate 
each of the countries, states or other components of these maps individually. The Maps and 
International Collection is only $19.00 and REQUIRES SmartDraw 3.0 or higher.



UK Order Form [Print this form using the Print Topic command]
The Thompson Partnership (United Kingdom)
You can order from The Thompson Partnership by payment with cheque or credit card.    The credit 
cards accepted are: MC, Visa, Diners Club, and American Express.    

Telephone Orders: +44 (0) 1889 564601 Fax Orders:+44 (0) 1889 563219
Internet Orders: sales@ttp.co.uk Internet Support: support@ttp.co.uk
Please use this form when ordering by fax or mail:
Name ______________________________Company_________________________________
Address _____________________________________________________________________
Town ______________________________ City _____________________________________
Country ________________ Postal Code ___________Telephone ______________________
Credit Card Type _____________Credit Card Number ________________________________
Expiration Date      _______VAT Number (EC Residents) _______________________________
Program Quantity Price Each Price Total
SmartDraw COMBO PACK ______ £34.95 ______
(Includes BOTH Windows 3.1 and Windows 95 Versions)
SmartDraw Flyers and Fun Collection ______ £12.99 ______
SmartDraw Maps and International Collection ______ £12.99 ______
SmartDraw v3    10 License Pack ______ £239.00 ______
SmartDraw v3    25 License Pack ______ £529.00 ______
SmartDraw v3    100 License Pack ______ £1890.00 ______
SmartDraw Flyers and Fun 10 License Pack ______ £99.00. ______
SmartDraw Flyers and Fun 100 License Pack ______ £695.00 ______
SmartDraw Maps and International 10 License Pack ______ £99.00. ______
SmartDraw Maps and International 100 License Pack ______ £695.00 ______
Additional Disks & Documentation (for multi-license pack) ______ £3.50 ______
Total ______
Shipping £3.00
VAT (EC REsidents only) @ 17.5% ______
Total ______
Make cheques or EuroCheque payable to: The Thompson Partnership.
(Be sure your card number is on the reverse of the Eurocheque)
Mail to:
The Thompson Partnership
Lion Buildings
Market Place
UTTOXETER,
Staffs.
ST14 8HZ,    UK

SmartDraw Ordering Information
Winner Best Business Program - Ziff Davis Awards (PC Magazine) 1996



Winner Best Graphics Program - SIA 1995
"..simple elegance..", "..a delight.." - PC Magazine July 1995

Order the SmartDraw v3 Combo Pack
SmartDraw v3    is available in both Windows 95 and Windows 3.1 Editions. When you order the 
SmartDraw COMBO PACK you automatically get BOTH versions of SmartDraw. This is ideal if 
you are still using Windows 3.1 but plan to upgrade to Windows 95 or NT 4.0 later. Have your cake and 
eat it too!

Order SmartDraw v3 and for just £34.95, here's what you get:
¨ Full versions of BOTH the Win 3.1 and Win 95 program with no time limit
¨ More than 1500 symbols and templates
¨ A 120 page printed and bound manual, with index and table of contents
¨ 90 days of paid support
¨ Notices of updates, and additional offers

If your time limit has expired! Place an order and we will reset your trial for 
another 30 days while you wait for delivery. 

SmartDraw Add-on Templates and Libraries
SmartDraw Flyers and Fun Collection
The SmartDraw Flyers and Fun Collection is a collection of more than 150 templates and clip-art images
designed for making one page flyers, posters, and signs. It has great-looking layouts for major holidays, 
celebrations and things you can use at the office. Kids will love it too. With the Flyers and Fun Collection 
you can use SmartDraw for all your drawing needs. The Flyers and Fun Collection is only £12.99 and
REQUIRES SmartDraw v3.

SmartDraw Maps and International Collection
The Maps and International Collection is a collection of more than 500 symbols and templates covering 
maps of the USA and the whole world. It includes the countries of America, Asia, Africa and Europe and 
the flags of 136 countries. 
The maps of individual countries (and US States) fit together to form a complete map of their entire 
region. This means you can create you own regional maps, or you can use those already assembled as 
templates. 
US Templates include The US by region (North East, Mid-West, Pacific etc.), by congressional district, 
by zip code, and the counties of each state. World templates include major regions of the world, 
including SE Asia, Central Asia, Central Europe, Russia, Middle East etc. You can color and manipulate 
each of the countries, states or other components of these maps individually. The Maps and 
International Collection is only £12.99 and REQUIRES SmartDraw v3.



SmartDraw v3 Bestelformulier voor Nederland & België
Gebruik Onderwerp Afdrukken / Print Topic om dit formulier te printen

SmartDraw wordt in de Benelux vertegenwoordigd door CopyCats Software & Services. Ook voor 
ondersteuning, upgrades en voordelige site-licenses kunt u bij CopyCats terecht. Om SmartDraw te 
bestellen stuurt u dit formulier, tezamen of gelijktijdig met uw betaling in Fl of BF, naar:

 CopyCats Software & Services Tel:  +31 (0)72 5745993
 Postbus 1088 Fax:  +31 (0)72 5726559
 1700 BB Heerhugowaard E-mail: copycats@compuserve.com
 Nederland BTW-Nr: NL 185.152.119.B01
SmartDraw wordt uit voorraad geleverd. Als de gebruikstijdlimiet van uw proefversie overschreden is en 
u direkt door wilt kunnen werken, neem dan even contact op. De complete versie van SmartDraw, het 
SmartDraw Combo-Pack, kost slechts Fl 138,00 / 2550 BF inclusief BTW. Voor die prijs krijgt u:

* De nieuwste, complete Win 3.1x en Win95/NT uitvoeringen van de software.    U krijgt 
zowel de 16- als de 32-bits uitvoering;

* Meer dan 1000 extra symbolen en cliparts;
* Een praktisch, gedrukt handboek met illustraties en index;
* Recht op technische ondersteuning;
* Bericht over het verschijnen van upgrades.
Los leverbaar zijn de add-ons SmartDraw Flyers & Fun Collection en de SmartDraw Maps 
Collection. Zie pagina 3 voor meer informatie over deze producten.
De producten op dit formulier zijn single-user versies bedoeld voor gebruik door één persoon (op max. 2
PCs). Gebruik het multi-user formulier op pagina 2 als 7 of meer mensen in uw organisatie SmartDraw 
willen gebruiken.
Naam    : ______________________________________________ M / V
Bedrijf : _____________________________________________________
Adres   : _____________________________________________________
Postcode: ______________________ Plaats: _____________________
Land    : ______________________ E-mail: _____________________
Tel.    : ______________________ Fax: ________________________
BTW-Nummer:|B|E|-|_|_|_|_|_|_|_|_|_| (Belgische bedrijven)

JA! SmartDraw bevalt mij. Ik bestel hierbij:
Aantal: Produkt: Prijs p/stuk: Totaal:
 ... SmartDraw v3 Combo-Pack 138,00 / 2550    .......
 ... SmartDraw Flyers Collection 44,95  /  835    .......
 ... SmartDraw Maps Collection 44,95  /  835    .......
 .1. Verzendkosten 8,50   /  160    ....... <-

-------
Levering op [ ] CD-ROM  [ ] Diskettes            Totaal:    .......

=======
Betaalwijze:
 [    ]    (NL+B) Bijgesloten betaalcheque of girobetaalkaart. Datum: ______-______-__________
[    ]    (NL) Overgemaakt op Postbank 43.28.577. Handtekening:
[    ]    (B) Overgemaakt op Postcheque 000-1656064-80.
[    ]    (NL+B) Op rekening (overheid, grootbedrijf). ____________________________________
Waar vond u deze evaluatie-versie van SmartDraw? _______________________________________________________
Voor welke doeleinden gebruikt u Smartdraw? ____________________________________________________________



Op deze pagina genoemde prijzen zijn inclusief 17,5% BTW, en zijn onder voorbehoud geldig tot 31-03-98. Bel na die datum eerst
voor actuele informatie. CopyCats S&S behoudt zich het recht voor om verzoeken tot levering op rekening te weigeren. Stuur bij 
gebruik van purchase orders a.u.b. ook dit formulier mee. Bedrijven in België, vermeld a.u.b. uw BTW-nummer zodat wij u geen 
BTW hoeven te berekenen!! (deel het totaalbedrag door 1,175).

SmartDraw v3 Bestelformulier Nederland & België / Multi-User
druk af m.b.v. Onderwerp Afdrukken / Print Topic commando

SmartDraw multi-user licenties zijn al voordeliger vanaf 7 gebruikers. Met een multi-user licentie kunt u 
SmartDraw gebruiken op meerdere PCs op dezelfde locatie of op hetzelfde netwerk. U ontvangt 
standaard één exemplaar van de software + handleiding, en een gebruikslicentie voor het betreffende 
aantal PCs. U kunt ook licenties voor andere dan de hieronder genoemde aantallen bestellen - vraag 
desgewenst een prijsopgaaf aan.
Vul om te bestellen dit formulier in, en stuur het tezamen of gelijktijdig met uw betaling in Fl of BF (of 
officiële bestelopdracht voor levering op rekening) naar:

 CopyCats Software & Services Tel:  +31 (0)72 5745993
 Postbus 1088 Fax:  +31 (0)72 5726559
 1700 BB Heerhugowaard E-mail: copycats@compuserve.com
 Nederland BTW-Nr: NL 185.152.119.B01

Naam    : ______________________________________________ M / V
Bedrijf : _____________________________________________________
Adres   : _____________________________________________________
Postcode: ______________________ Plaats: _____________________
Land    : ______________________ E-mail: _____________________
Tel.    : ______________________ Fax: ________________________
BTW-Nummer:|B|E|-|_|_|_|_|_|_|_|_|_| (Belgische bedrijven)
Ja! SmartDraw bevalt ons. Wij bestellen hierbij:
Aantal:  Produkt                       Prijs p.stuk:       Totaal:
 ...     SmartDraw 10 PC license       fl  725,00/13450 BF  ......
 ...     SmartDraw 25 PC license          1675,00/29995     ......
 ...     SmartDraw 100 PC license         5880,00/108750    ......
 ...     Extra set handleiding + disks      15,00/275       ......
 ...     SmartDraw Flyers Coll. 10 PC      295,00/5455      ......
 ...     SmartDraw Flyers Coll. 100PC     1995,00/36900     ......
 ...     SmartDraw Maps Coll. 10 PC        295,00/5450      ......
 ...     SmartDraw Maps Coll. 100PC       1995,00/36900     ......
 .1.     Verzendkosten                       8,50/160       ......
                                                           +------
                                               Subtotaal:   ......
Levering op [ ] CD-ROM  [ ] Diskettes          BTW 17,5%:   ......
                                                           +------
                                                  Totaal:   ......
                                                            ======
Betaalwijze:
[    ]    (NL+B) Bijgesloten betaalcheque of girobetaalkaart. Datum: ____-____-_______
[    ]    (NL) Overmaking naar Postbank 43.28.577. Handtekening:
[    ]    (B) Overmaking naar Postcheque 000-1656064-80.
[    ]    (NL+B) Op rekening (overheid en grootbedrijf). ________________________



Waar vond u deze evaluatie-versie van SmartDraw? _______________________________________________________
Voor welke doeleinden gebruikt u SmartDraw? ____________________________________________________________
Bedrijven en instellingen in België, vermeld uw BTW-nummer zodat wij u geen BTW in rekening hoeven te brengen! 
Prijzen exclusief 17,5% BTW, onder voorbehoud geldig t/m 31-3-98. Bel na die datum voor actuele prijzen.
CopyCats Software & Services behoudt zich het recht voor om verzoeken tot levering-op-rekening te weigeren. Stuur met 
purchase orders a.u.b. ook altijd dit formulier mee.

Onderwijsgevenden opgelet: Informeer naar onze speciale onderwijslicenties!

Goede redenen om voor SmartDraw te kiezen:

· Met SmartDraw kunt u snel aan de slag. Het programma is snel te leren en door het praktische en 
gebruiksvriendelijke ontwerp komt u meteen tot resultaten.

· SmartDraw is krachtig en compleet uitgevoerd, zonder u het zicht te ontnemen met allerlei 
mogelijkheden die u nooit zult gebruiken.
· SmartDraw werkt probleemloos samen met uw office-applicaties.
· SmartDraw heeft alle benodigde symbolen voor het tekenen van organisatie- en 
procesdiagrammen volgens officiële normen. Het biedt daarnaast symbolen uit diverse vakgebieden, en u
kunt gemakkelijk uw eigen symbolen toevoegen.
· U krijgt kostenloze ondersteuning bij de helpdesk van CopyCats S&S.
· SmartDraw wordt gebruikt door veel van Nederlands grootste bedrijven en instellingen.
· U kunt het programma voor aankoop voor 100% testen.
· SmartDraw is bijzonder vriendelijk geprijsd, en heeft in de vakpers alleen goede tot uitmuntende 
recensies gehad. Bijvoorbeeld..:

Best Graphics Program, 1995 (S.I.A.F. Award)
Best Business Program, 1997 (S.I.A.F. Award)
Gold Product Award (PC Plus Magazine, UK)

"..simple elegance..", "..a delight.." - PC Magazine, USA July 1995
"A smart choice for the occasional illustrator." - PC Magazine, USA January 1996

"Remarkable ease of use and ample power ... at a bargain basement price." 
PC Magazine, USA March 1997

Best Business Program - Ziff Davis Awards (PC Magazine) 1996
"SmartDraw 2.0 zeichnet sich durch exzellentes Preis-Leistungs-Verhältnis

und hohe Flexibilität aus" (PC Direkt 3/96, Germany)
Superior Shareware - Windows Magazine

Five Picks (Highest Rating) - FileMine
Most Popular - Download.Com
Editors Pick - Download.Com

Editors Pick - SoftSeek
Worlds Best Shareware - The Shareware Shop

SmartDraw add-ons: 
SmartDraw kan meer dan alleen diagrammen maken! Het programma is geschikt voor allerlei vormen 
van zakelijke illustraties - denk aan grafieken voor overheadsheets, afbeeldingen voor home-pages, 
uitnodigingen, aankondigingen enzovoort. Om de zeggingskracht van uw werk verder te vergroten, biedt
SmartDraw Software Inc. twee los leverbare verzamelingen met kant en klare illustraties:

SmartDraw Flyers & Fun Collection:
Met de SmartDraw Flyers Collection krijgt u een collectie van 150 cliparts en backdrops (pagina-grote 
achtergrondillustraties) in handen voor het maken van folders, posters, oorkondes, aankondigingen en 
dergelijke. Het bevat illustraties voor feestdagen en zakelijke gelegenheden zoals memo's, diplo-ma's, 



uitnodigingen, rapporten, enzovoort. De diverse elementen van deze afbeeldingen kunt u ook als losse 
clip-art gebruiken.

SmartDraw Maps & International Collection
Naast schaalbare kaarten van landen, continenten, regios en Amerikaanse staten bevat de Maps 
collectie afbeeldingen van 136 vlaggen. De afbeeldingen (smartdrawings en templates) sluiten nauw op 
elkaar aan en kunnen individueel ingekleurd worden. Let op: kleine landen, zoals Nederland en België, 
vertonen weinig detail en zijn minder geschikt voor gebruik op groot formaat.



SmartDraw Bestellformular: Deutschland
bitte ausdrucken mit "Thema drucken" in obigem Menü.

Als deutscher SmartDraw-Anwender können Sie die Vollversion einfach bei CopyCats Software & Services, der 
niederländischen Vertretung von SmartDraw Software Inc., anfordern.    Bitte füllen Sie dieses Formular aus und 
senden Sie es zusammen mit Ihrer Bezahlung an:
 CopyCats Software & Services    Tel: +31 72 5745993
 Postbus 1088                    Fax: +31 72 5726559
 NL-1700BB Heerhugowaard         E-mail: copycats@compuserve.com
 Niederlande                     UID-Nr: NL 185.152.119.B01
SmartDraw wird ab Lager geliefert. Falls das Zeitlimit dieser Testversion abgelaufen ist und Sie dennoch sofort 
weiter arbeiten möchten, setzen Sie sich bitte mit CopyCats in Verbindung. Die SmartDraw Vollversion, das 
SmartDraw Combo-Pack, kostet nur DM 117,50 inklusive MwSt. Für diesen Betrag erhalten Sie:

* Die neuesten Vollversionen für Win 3.1x (16-bit) und Win95/NT (32-bit);
* Mehr als 1000 zusätzliche Symbole, Smartdrawings und Templates;
* Ein praktisches, professionell gedrucktes SmartDraw-Handbuch mit Index;
* Anspruch auf technische Unterstützung;
* Benachrichtigung bei Erscheinen einer neuen Version;

Die Produkte auf dieser Seite sind für je einen Benutzer (auf max. zwei Rechnern) bestimmt. Bitte benutzen Sie das
Formular für Mehrfachlizenzen auf Seite 2, wenn in Ihrem Unternehmen sieben oder mehr Personen SmartDraw 
einsetzen wollen. Einzeln erhältlich sind außerdem die SmartDraw Flyers Collection und die Maps Collection. 
Weitere Einzelheiten zu diesen Produkten finden Sie auf Seite 3.

Name   : ___________________________________________________________
Firma  : ___________________________________________________________
Straße : ___________________________________________________________
PLZ    : _______________________ Ort: ______________________________
Land   : _______________________ E-mail: ___________________________
Telefon: _______________________ Fax: ______________________________
UID-Nr (Firmen): |D|E|-|_|_|_|_|_|_|_|_|_|(Sieh unten)
Ja, SmartDraw gefällt mir! Hiermit bestelle ich:
Menge: Bezeichnung:                Einzelpreis  Gesamtpreis:
 ...   SmartDraw Combo-Pack          DM 117,50       .......
 ...   Flyers & Fun Collection           39,00       .......
 ...   Maps & International Coll.        39,00       .......
 .1.   Versandkosten                     10,00       ..10,00
                                                     -------
Lieferung auf [ ] CDROM  [ ] Disks         Summe: DM .......
                                                     =======
Anm.: Alle Preise inklusive 17,5% Niederländischen MwSt.    Firmen: Falls Sie Ihre gültige, neunstellige UStID.-Nr. angegeben haben,

berechnen wir die Preise ohne MwSt.! Um auf den Nettopreis zu kommen, teilen Sie bitte die Summe durch Faktor 1,175.

Ich zahle per:                                 Datum: ...-...-19...
[ ] Scheck (beiliegend) Unterschrift:
[ ] Überweisung auf CopyCats Konto

556.33.666 BLZ 590.100.66 bei
    Postbank Saarbrücken.
[ ] Auf Rechnung (Großbetriebe/Behörden*) ____________________



*: Bitte nur mit offiziellem Kaufauftrag auf Briefbogen oder mit Stempel..

Wo haben Sie diese Testversion erhalten?:    ______________________________________________

Vielen Dank für Ihren Auftrag!
SmartDraw Bestellformular: Deutschland / Mehrfachlizenzen
bitte ausdrucken mit "Thema drucken" in obigem Menü.

Mit diesem Formular können Sie Mehrfachlizenzen von SmartDraw bestellen. Mehrfachlizenzen lohnen sich bereits 
ab sieben Anwendern. Bei einer Mehrfachlizenz erhalten Sie ein Exemplar der Vollversion (Software und 
Handbuch). Bitte füllen Sie dieses Formular aus und senden Sie es zusammen mit der Bezahlung oder mit 
offiziellem Kaufauftrag an:
CopyCats Software & Services    Tel: +31 72 5745993
 Postbus 1088                    Fax: +31 72 5726559
 NL-1700BB Heerhugowaard         E-mail: copycats@compuserve.com
 Niederlande                     UID-Nr: NL 185.152.119.B01
SmartDraw wird ab Lager geliefert. Falls das Zeitlimit dieser Testversion abgelaufen ist und Sie dennoch sofort 
weiter arbeiten möchten, setzen Sie sich bitte mit CopyCats in Verbindung.

Bei Bestellung von SmartDraw erhalten Sie:

* Die neuesten Vollversionen für Win 3.1x (16-bit) und Win95/NT (32-bit);

* Mehr als 1000 zusätzliche Symbole, Smartdrawings und Templates;
* Ein praktisches, professionell gedrucktes SmartDraw-Handbuch mit Index;
* Anspruch auf technische Unterstützung;
* Benachrichtigung bei Erscheinen einer neuen Version.

Einzeln erhältlich sind außerdem die SmartDraw Flyers & Fun Collection und die Maps & International Collection. 
Weitere Einzelheiten zu diesen Produkten finden Sie auf Seite 3.

Name   : ___________________________________________________________
Firma  : ___________________________________________________________
Straße : ___________________________________________________________
PLZ    : _______________________ Ort: ______________________________
Land   : _______________________ E-mail: ___________________________
Telefon: _______________________ Fax: ______________________________
UID-Nr (Firmen): |D|E|-|_|_|_|_|_|_|_|_|_|(Sieh unten)

Ja, SmartDraw gefällt uns! Wir bestellen hiermit:
Menge:  Bezeichnung:                 Einzelpreis:  Gesamtpreis:
 ...    SmartDraw 10er PC-Lizenz          DM 659,00      ......
 ...    SmartDraw 25er PC-Lizenz            1495,00      ......
 ...    SmartDraw 100er PC-Lizenz           5345,00      ......
 ...    Extra-Set Handbuch und Disketten      15,00      ......
 ...    Flyers Collection 10er PC-Lizenz     275,00      ......
 ...    Flyers Collection 100er PC-Lizenz   1825,00      ......
 ...    Maps Collection 10er PC-Lizenz       275,00      ......
 ...    Maps Collection 100er PC-Lizenz     1825,00      ......
 .1.    Versandkosten                         10,00      .10,00                                                        +------
    MwSt. 17,5% (nur wenn keine UID-Nr. angegeben ist):  ......



                                                         ------
Lieferung auf [ ] CDROM  [ ] Disks             Summe: DM ......
                                                         ======
Wir zahlen per:
[ ] Scheck (beiliegend) Datum: ...-...-19...
[ ] Überweisung auf CopyCats Konto Unterschrift:

556.33.666 BLZ 590.100.66 bei
    Postbank Saarbrücken.
[ ] Auf Rechnung (Großbetriebe/Behörden*)
*: Bitte nur mit offiziellem Kaufauftrag auf Briefbogen oder mit Stempel. CopyCats S&S behält sich das Recht vor, bestimmte Anträge auf Lieferung 
gegen Rechnung abzulehnen.    Die Preise auf diesem Blatt sind exklusive 17,5% Niederländischen MwSt. 

Vielen Dank für Ihren Auftrag!
Gute Gründe, sich für SmartDraw zu entscheiden:

* Sie haben SmartDraw schnell im Griff! Das Programm ist leicht zu erlernen und dank der intuitiven 
Bedienung kommen Sie schnell zum gewünschten Ergebnis.

* SmartDraw ist ein mächtiges, komplett ausgestattetes Programm mit hervorragendem Leistungs-
umfang, bei dem Sie aber nicht wegen überflüssiger Funktionen die Übersicht verlieren. 
* SmartDraw arbeitet als OLE-Server reibungslos mit Ihren Office-Anwendungen zusammen.
* SmartDraw verfügt über all die wichtigen Symbole, die Sie benötigen, um Organisationsplanung 
und Ablaufdiagramme nach internationalen Standards zu erstellen. Zusätzlich finden Sie zahlreiche 
Symbole für viele unterschiedliche Fachbereiche, und sie können problemlos eigene Symbole erstellen 
und verwenden. 
* SmartDraw ist äußerst preiswert.
* SmartDraw erhielt bislang ausschließlich gute bis hervorragende Beurteilungen in der 
Fachpresse. Einige Highlights:

Best Graphics Program, 1995 (S.I.A.F. Award)
Best Business Program, 1997 (S.I.A.F. Award)
Gold Product Award (PC Plus Magazine, UK)

"..simple elegance..", "..a delight.." - PC Magazine, USA July 1995
"A smart choice for the occasional illustrator." - PC Magazine, USA January 1996

"Remarkable ease of use and ample power ... at a bargain basement price." 
PC Magazine, USA March 1997

Best Business Program - Ziff Davis Awards (PC Magazine) 1996
"  SmartDraw 2.0 zeichnet sich durch exzellentes Preis-Leistungs-Verhältnis  

und hohe Flexibilität aus" (PC Direkt 3/96, Germany)
Superior Shareware - Windows Magazine

Five Picks (Highest Rating) - FileMine
Most Popular - Download.Com
Editors Pick - Download.Com

Editors Pick - SoftSeek
Worlds Best Shareware - The Shareware Shop

SmartDraw Flyers & Fun Collection:

Die SmartDraw Flyers Collection enthält 150 Clip-arts und ganzseitige Hintergrundbilder für den 
geschäftlichen und privaten Einsatz. Diese Sammlung eignet sich besonders für Poster, Bekannt-



machungen, Urkunde, Einladungen, Rundschreiben, Faltblätter usw.

SmartDraw Maps & International Collection:

Über 500 Symbole mit Karten von Ländern (in Europa, Asien und Afrika), Regionen, Amerikanischen 
Staaten und Flaggen. Die Karten können genau aneinander gefügt werden.



Bon de commande (licence individuelle) 
[Faites FICHIER|IMPRIMER LA RUBRIQUE pour imprimer le bon de commande]

Paiement par chèque bancaire ou postal, eurochèque ou carte de crédit (MasterCard et Visa).
Veuillez adresser ce bon de commande à :

WindowShare SARL Téléphone : +33 387 30 85 57
46-48, route de Thionville Télécopie : +33 387 32    37 75
Zone de Maison-Neuve Minitel : 3615 WinShare
57140      WOIPPY CompuServe : Go WSHARE

Nom __________________________________________________________________
Société __________________________________________________________________
Adresse __________________________________________________________________
Adresse __________________________________________________________________
Code postal ___________ Ville _____________________________
Pays ___________________________
Téléphone ____________________
Numéro de carte de crédit _____________________________
Date d'expiration ________/_________
Prix valables jusqu'en Décembre 1997

Licence individuelle
Cette licence permet l'utilisation de SmartDraw sur un seul ordinateur ou sur deux au maximum, à condition qu'ils soient utilisés 
par la même personne. Elle inclut une copie du programme et sa documentation.

SmartDraw v3 COMBO PACK……… Copies _____ x FF 425……… ______
(Deux versions: une pour Windows 3.1 et une pour Windows 95)

Dessins et Modèles de documents
SmartDraw Flyers Collection.. Copies _____ x FF 210 ………… ______

SmartDraw Flyers Collection est un ensemble de 300 modèles de documents et de SmartDrawings (des dessins de toutes 
catégories) conçus pour vous aider à réaliser des prospectus, des posters, des écriteaux, des panneaux...

Images with Impact………… Copies _____ x FF 590…………______
Images with Impact est une collection de 1000 images vectorisées (au format WMF) pouvant être importées dans SmartDraw ainsi
que dans d'autres programmes Windows.

Port (25FF métropolitaine, 35F outremer et étranger) ______

Total (TVA 20,6% incluse) : ______

Paiement par : carte de crédit ______          chèque bancaire ______
Disquettes 3.5" Disks (1.44MB) seulement
Veuillez nous contacter pour des licences multiples

Licences multiples
Cette licence vous permet d'utiliser SmartDraw sur un certain nombre d'ordinateurs utilisés au même endroit (c'est une licence sur
site) ou sur le même réseau. Elle n'inclut qu'une copie du programme et de sa documentation. Il vous est possible de combiner 
des licences pour 1, 10 ou 100 ordinateurs de façon à s'adapter à vos besoins.

SmartDraw v3 COMBO PACK(Deux versions: une pour Windows 3.1 et une pour Windows 95)
10 Ordinateurs ou moins…………
100 Ordinateurs ou moins………



Manuels et disquettes supplémentaires………

Dessins et Modèles de documents
SmartDraw Flyers Collection

10 Ordinateurs ou moins…………
100 Ordinateurs ou moins………

SmartDraw Flyers Collection est un ensemble de 300 modèles de documents et de SmartDrawings (des dessins de toutes 
catégories) conçus pour vous aider à réaliser des prospectus, des posters, des écriteaux, des panneaux...

Images with Impact
Images with Impact est une collection de 1000 images vectorisées (au format WMF) pouvant être importées dans SmartDraw ainsi
que dans d'autres programmes Windows.

Winner Best Graphics Program - Shareware Industry Awards 1995
(Vainqueur dans la catégorie Programmes de dessin 

aux "Oscars" 1995 de l'industrie du Shareware)

SmartDraw Flyers Collection
SmartDraw Flyers Collection est un ensemble de 300 modèles de documents et de SmartDrawings (des
dessins de toutes catégories) conçus pour vous aider à réaliser des prospectus, des posters, des 
écriteaux, des panneaux et toutes sortes de documents d'une seule page. Il contient des modèles 
prédessinés répondant à la plupart des besoins (prospectus pour des vacances, notices, publicités, ...). 
Avec le Flyers Collection, vous pouvez utiliser SmartDraw pour répondre à tous vos besoins au niveau 
du dessin. Le Flyers Collection ne coûte que 210 FF.

Images with Impact!
Images with Impact! est une collection de plus de 1000 images vectorisées (au format Windows WMF) 
et réalisées par la société 3G Graphics Inc. Beaucoup sont en couleurs. Elles peuvent être importées 
dans SmartDraw. Les Images with Impact! appartiennent à des domaines très variés allant des 
éléments pour présentations jusqu'aux voyages, en passant par la maison, le bureau, les affaires, les 
sports, les vacances, la santé, et d'autres domaines encore. Vous pouvez ajouter les images importées 
dans vos bibliothèques SmartDraw personnelles ou créer des fichiers-modèles. De la même façon que 
pour SmartDraw, beaucoup de ces images sont des fonds de pages et rendent SmartDraw plus efficace 
dans la réalisation de prospectus, de posters, d'invitation et de notices. Les images de cette collection 
sont différentes de celles contenues dans le Flyers Collection.

Vous pouvez acquérir Images with Impact, d'une valeur de plus de 1000 FF, au prix 
exceptionnellement bas de 590 FF lorsque vous commandez SmartDraw.



SmartDraw Order Form (Single Use)    [Print this form using the Print Topic 
command]

(Check out the order.jpn file for an order form in Japanese)
A Single Use License that permits the use of SmartDraw on a single computer, or on up to two computers used exclusively by the 
same individual user. It includes one copy of the program and its documentation. 

Shipping Information
Name_________________________________    Company______________________________
Address_____________________________________________________________________    
City______________________________________ Postal Code ___________ 
Phone ____________________ Fax _____________________ EMail____________________

Programs Ordered
SmartDraw v3 COMBO PACK …… Copies required _____ x Yen 7,800 ………… ______
(Includes both 16 bit Windows 3.1 and 32 bit Windows 95 versions of SmartDraw)

Add-on Templates and Libraries Ordered
Flyers and Fun Collection………… Copies required _____ x Yen 2,500………… ______
Maps and International…………… Copies required _____ x Yen 2,500………… ______

Consumption Tax 
Subtotal: Cost of    Products………… ______
 add 3% Consumption Tax ______

Shipping and Handling Costs are included in the above prices

GRAND TOTAL………………… _____

Payment Information
Payment Method:    ___    Credit Card        ___    Bank Transfer    ____ Postal Transfer    ____ Cash

            ____ C.O.D. (+ yen 700)
Credit Card Information. (Visa ,MasterCard, DC    or American Express). 
Number: __ __ __ __    __ __ __ __    __ __ __ __    __ __ __ __      
Name:          __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __    _
Expires    __ __    / __ __      Signature_______________________

How to Order
Mail this order form to:
P. & A. Inc.
No.3 Hoko Bldg. 6F
2-29-13 Akebono, Tachikawa
Tokyo 190-0012 JAPAN

email: info@panda.co.jp

or, Fax the form, with credit card information filled in below, to    (042) 525-9502
or, call P. & A. Shareware at    (042) 525-9501
or, order on-line using the web: http://www.panda.co.jp
or, order on-line using NiftyServe. Just GO PAF02461, and follow the instructions.

SmartDraw Order Form (Multiple Use License)
A Multiple Use License permits the use of SmartDraw on more than one computer used as the same site (a site license), or on the 



same network. It includes only one copy of the program and documentation.    You may buy any combination of 1, 10, or 100 copy 
licenses to meet your needs. (Check out the order.jpn file for an order form in Japanese)
Shipping Information
Name_________________________________    Company______________________________
Address_____________________________________________________________________    
City______________________________________ Postal Code ___________ 
Phone ____________________ Fax _____________________ EMail____________________

Products Ordered
SmartDraw v3 COMBO PACK (Includes both Windows 3.1 and Windows 95 versions)

10 Computers or less………… Copies required _____ x Yen 50,000………… ______
25 Computers or less………… Copies required _____ x Yen 110,000………… ______
100 Computers or less……… Copies required _____ x Yen 380,000………… ______

Extra Manuals and Disks……… Copies required _____ x Yen 600…………… ______
SmartDraw Flyers and Fun Collection

10 Computers or less………… Copies required _____ x Yen 18,000 ……… ______
100 Computers or less……… Copies required _____ x Yen 130,000………… ______

SmartDraw Maps and International Collection
10 Computers or less………… Copies required _____ x Yen 18,000 ………… ______
100 Computers or less……… Copies required _____ x Yen 130,000………… ______

Consumption Tax               Subtotal: Cost of    Products………                            
_____

 add 3% Consumption Tax ______
Shipping and Handling Costs are included in the above prices

GRAND TOTAL………………… _____
Payment Information
Payment Method:    ___    Credit Card        ___    Bank Transfer    ____ Postal Transfer    ____ Cash

            ____ C.O.D. (+ yen 700)
Credit Card Information. (Visa ,MasterCard, DC    or American Express). 
Number: __ __ __ __    __ __ __ __    __ __ __ __    __ __ __ __      
Name:          __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __    _
Expires    __ __    / __ __      Signature_______________________

How to Order
+Mail this form and payment to: P. & A. Shareware 

1-3-6-2 Kamisuna, Tachikawa, Tokyo      190 Japan
+or, Fax the form, with credit card information filled in below, to (0425) 35-9902
+or, call P. & A. at (0425) 35-9901 
+or, order on-line using the web: http://www.pandasw.com
+or, order on-line using NiftyServe. Just GO SPANDA, and follow the instructions.
All products shipped on 3.5" Disks (1.44MB). Prices good through December 1996

SmartDraw Ordering Information
Winner Best Business Program - Ziff Davis Awards (PC Magazine) 1996

Winner Best Graphics Program - SIA 1995
"..simple elegance..", "..a delight.." - PC Magazine July 1995

Order the SmartDraw v3 Combo Pack
SmartDraw v3 is available in both Windows 95 and Windows 3.1 Editions. When you order the 



SmartDraw COMBO PACK you automatically get BOTH versions of SmartDraw. This is ideal if 
you are still using Windows 3.1 but plan to upgrade to Windows 95 or NT 4.0 later. Have your cake and 
eat it too!

Order SmartDraw v3 and for just Yen 7,800, here's what you get:
¨ Full versions of BOTH the Win 3.1 and Win 95 program with no time limit
¨ More than 1000 additional symbols
¨ A printed manual in Japanese
¨ 90 days of paid support
¨ Notices of updates, and additional offers

If your time limit has expired! Place an order and we will reset your trial for 
another 30 days while you wait for delivery. 

SmartDraw Add-on Templates and Libraries
SmartDraw Flyers and Fun Collection
The SmartDraw Flyers and Fun Collection is a collection of more than 150 templates and clip-art images
designed for making one page flyers, posters, and signs. It has great-looking layouts for major holidays, 
celebrations and things you can use at the office. Kids will love it too. With the Flyers and Fun Collection 
you can use SmartDraw for all your drawing needs. The Flyers and Fun Collection is only Yen 2,500 
and REQUIRES SmartDraw v3.

SmartDraw Maps and International Collection
The Maps and International Collection is a collection of more than 500 symbols and templates covering 
maps of the USA and the whole world. It includes the countries of America, Asia, Africa and Europe and 
the flags of 136 countries. 
The maps of individual countries (and US States) fit together to form a complete map of their entire 
region. This means you can create you own regional maps, or you can use those already assembled as 
templates. 
US Templates include The US by region (North East, Mid-West, Pacific etc.), by congressional district, 
by zip code, and the counties of each state. World templates include major regions of the world, 
including SE Asia, Central Asia, Central Europe, Russia, Middle East etc. You can color and manipulate 
each of the countries, states or other components of these maps individually. The Maps and 
International Collection is only Yen 2,500 and REQUIRES SmartDraw v3.



SmartDraw Modulo d'Ordine (Licenza Utente Singolo)    
[Stampa questo modulo col comando Stampa]    

Preleva gratuitamente l'ultima versione Shareware di SmartDraw 
da ARES BBS - Tel. +39-2-50.61.706 (8n1) in area Windows. 
Oppure collegati su Internet allindirizzo WWW.ITAWARE.COM e 
seleziona Shareware Magazine di Dicembre 1996 per una 
recensione on line.          
La licenza Singolo Utente permette l'uso di SmartDraw    su di un singolo computer, oppure fino al massimo di due computer usati 
esclusivamente dallo stesso singolo utente. Essa include una copia del programma e la sua documentazione.

Informazioni per la Spedizione
Nome_______________________________________    
Azienda/Societa'______________________________
Via________________________________________________________________________    
Citta'__________________________ CAP___________ Stato________________________
Telefono ____________________ Fax _____________________ 
EMail__________________________

Programmi Ordinati
SmartDraw v3 COMBO PACK…… Copie richieste _____ x L.80.000………… ______
(Include la versione Windows 3.1 a 16 bit e quella per    Windows 95 a 32 bit )
Add-on Templates e Libraries Ordinate
Flyers and Fun Collection………… Copie richieste _____ x L.30.000.………… ______
Maps and International…………… Copie richieste _____ x L.30.000.…………                    ______

Totale parziale: Prezzo dei Prodotti……….......                     ______

Spese di Spedizione

ITALIA: (via Aerea)[L. 17.000 per il primo prodotto + L. 8.000 per ogni prodotto aggiuntivo]
…........................................................................................................          ______

TOTALE GENERALE………………… _____

Format : ____ su floppy da 3.5 (1.44 MB) _____ su CD-ROM

Informazioni di Pagamento
Metodo di Pagamento:    ___    Assegno        ___ Vaglia Postale [CHIAMARE PRIMA]

Come Ordinare
+Spedire questo modulo insieme all'assegno o vaglia a:
                                                                                                  Bertone Stefano., 

via Flli Cervi 49, 27010    Siziano (PV)
                                                                                                                          Tel. 0382-617919 / 03-30689120

Prezzi validi fino al Dicembre 1997, salvo variazioni del cambio Lira/ Dollaro (telefonare per conferma).



SmartDraw Modulo d'Ordine (Licenza Multipla)
Una Licenza Multipla    permette l' uso di SmartDraw su piu' di un computer nello stesso luogo (in inglese site license), o sulla 
stessa rete. Essa include solamente una copia del programma e della documentazione.    E' possibile acquistare una 
combinazione di    1, 10, o 100 copie di licenze in base alle proprie esigenze.

Informazioni per la Spedizione
Nome_______________________________________    
Azienda/Societa'______________________________
Via________________________________________________________________________    
Citta'__________________________ CAP___________ Stato________________________
Telefono ____________________ Fax _____________________ 
EMail___________________________

Programmi Ordinati
SmartDraw v3 COMBO PACK (Include sia la versione Windows 3.1 che Windows 95 )

10 Computers o meno………… Copie richieste _____ x L.      540.000..………… ______
25 Computers or less………… Copie richieste _____ x L. 1.240.000.....……… ______
100 Computers or less……… Copie richieste _____ x L. 4.340.000……..…… ______

Manuali e Dischi aggiuntivi……… Copie richieste    _____x L.              8.000…………… ______
SmartDraw Flyers and Fun Collection

10 Computers or less………… Copie richieste _____ x L.        220.000………… ______
100 Computers or less……… Copie richieste _____ x L.1.550.000.………… ______

SmartDraw Maps and International Collection
10 Computers  o meno..........      Copie richieste _____ x L.      220.000.………… ______
100 Computers o meno ………Copie richieste _____ x L.1.550.000….……… ______

Spese di Spedizione

ITALIA: (via Aerea)[L. 17.000 per il primo prodotto + L. 8.000 per ogni prodotto aggiuntivo]
…........................................................................................................          ______

TOTALE GENERALE………………… _____

Format : ____ su floppy da 3.5 (1.44 MB) _____ su CD-ROM

Informazioni di Pagamento
Metodo di Pagamento:    ___    Assegno        ___ Vaglia Postale [CHIAMARE PRIMA]

Come Ordinare
+Spedire questo modulo insieme all'assegno o vaglia a:
                                                                                                  Bertone Stefano., 

via Flli Cervi 49, 27010    Siziano (PV)
                                                                                                                          Tel. 0382-617919 / 03-30689120

Prezzi validi fino al Dicembre 1997, salvo variazioni del cambio Lira/Dollaro (telefonare per conferma).



SmartDraw    Informazioni aggiuntive
Vincitore Best Business Program - Ziff Davis Awards (PC Magazine) 1996

Vincitore Best Graphics Program - SIA 1995
"..simple elegance..", "..a delight.." - PC Magazine July 1995

Ordina SmartDraw v3 Combo Pack
SmartDraw v3 e disponibile    nelle versioni per    Windows 95 e Windows 3.1. Ordinando SmartDraw
COMBO PACK si ottengono automaticamente    ENTRAMBE  le versioni di SmartDraw. Questa 
offerta e ideale se si sta usando ancora Windows 3.1 ma si progetta di aggiornarsi    nel futuro a 
Windows 95 o NT 4.0. Unottima opportunita!

Ordina SmartDraw v3 e per sole    L. 80.000, avrete:
¨ ENTRAMBE le versioni complete per Win 3.1 e Win 95 senza limiti di tempo
¨ Piu di 1000 simboli aggiuntivi
¨ Un completo manuale stampato di 120 pagine, con indice e tavola dei contenuti
¨ 90 giorni di assistenza gratuita
¨ Notizie di aggiornamenti    e offerte supplementari

Se il vostro periodo    di prova e gia scaduto, ordinando SmartDraw vi 
riattiveremo il programma per altri 30 giorni in attesa della ricezione della copia 
registrata. 

SmartDraw Add-on Templates e Librerie
SmartDraw Flyers and Fun Collection
SmartDraw Flyers e Fun Collection e una libreria di oltre 150 templates e immagini clip-art    pensate per
creare volantini, posters e insegne. Essa ha un grande impatto visivo utile per le maggiori ricorrenze 
come ad esempio feste, affari e avvisi. Anche i bambini ne saranno affascinati. Con Flyers e Fun 
Collection e' possibile usare SmartDraw    per tutti i tipi di disegni che servono. Flyers e Fun Collection 
costa solo L. 30.000 e RICHIEDE SmartDraw v3.

SmartDraw Maps e International Collection
Maps e International Collection e una raccolta di oltre    500 simboli e templates riguardanti le mappe 
degli USA    e dellintero mondo. Esso include i continenti dellEuropa, America, Asia, Africa e    le bandiere
di 136 nazioni. 
Le mappe di una nazione (e degli stati USA) sono composte dalle loro singole regioni, in modo che sia 
possibile creare mappe regionali, usare quelle pronte oppure crearne di altre come template.
Quella degli USA include le singole regioni (Nord Est, Ovest, Pacifico, etc.), separate per distretto e 
codice postale. I templates del mondo includono i continenti    come lEuropa, SE Asia, lASIA Centrale, la 
Russia, il Medio Oriente etc. E possibile colorare e modificare ogni stato o regione o qualsiasi 
componente della mappa in modo separato. Maps e International Collection costa solo L. 30.000 e 
RICHIEDE SmartDraw v3.



SmartDraw Korean Order Form (Single User)    

A Single User License that permits the use of SmartDraw on a single computer, or on up to two computers used exclusively by the 
same individual user. It includes one copy of the program and its documentation.

Shipping Information
Name_________________________________    Company______________________________
Street________________________________________________________________________    
City__________________________ State_____ ZIP___________ Country________________
Phone ____________________ Fax _____________________ EMail____________________

Programs Ordered
SmartDraw 3    (CD ROM) …………………….. Quantity _____ x KRW 81,000………… ______
(Includes both 16 bit Windows 3.1 and 32 bit Windows 95 versions of SmartDraw)

Add-on Templates and Libraries Ordered
Flyers and Fun Collection…………………….Quantity _____ x KRW 32,000………… ______
Maps and International………………………..Quantity _____ x KRW 32,000………… ______

Diskette Media
3.5 Diskettes: [Pricing above includes CD -ROM, add KRW 9,000 for diskettes] ______

VAT (10%)
Subtotal: Cost of    Products………… ______

add 10% VAT ______

GRAND TOTAL……………… _____

Shipping and Handling Costs are included in above prices

Payment Method by Bank Transfer or Postal Transfer

For Ordering or More Information:

ASC Co. (Analytical Solutions & Consulting Corp.)
B-1701, Samhomulsan Bldg. 275-6
Yangjae-Dong, Seocho-Ku
Seoul, Korea, 137-130

Phone : 02-589-2011 / 2 
Fax : 02-589-2010
E-Mail : ascco@nownuri.net

SmartDraw Korean Order Form    (Multiple User License)
A Multiple User License permits the use of SmartDraw on more than one computer used as the same site (a site license), or on the



same network. It includes only one copy of the program and documentation.

Shipping Information
Name_________________________________    Company______________________________
Street________________________________________________________________________    
City__________________________ State_____ ZIP___________ Country________________
Phone ____________________ Fax _____________________ EMail____________________

Products Ordered (all licenses include 1 set of Manuals & CD ROM)
SmartDraw 3.1 (CD ROM) (Includes both Windows 3.1 and Windows 95 versions)

10-24 Computers ................. Quantity _____ x KRW 57,000 ______
25-99 Computers ................. Quantity _____ x KRW 48,000 ______ 
100+ Computers .................. Quantity _____ x KRW 42,000 ______

Extra Manuals and Disks ......... Quantity _____ x    KRW    7,500 ______

SmartDraw Flyers and Fun Collection
10-99 Computers ................. Quantity _____ x KRW 21,000    ______
100+ Computers    ................. Quantity _____ x KRW 15,000    ______

SmartDraw Maps and International Collection
10-99 Computers ................. Quantity _____ x KRW 21,000    ______
100+ Computers    ................. Quantity _____ x KRW 15,000    ______

Diskette Media
3.5 Diskettes: [Pricing above includes CD ROM, add 9,000 KRW for diskettes]             

VAT (10%)
Subtotal: Cost of    Products………… ______

add 10% VAT ______

GRAND TOTAL………………… _____

Shipping and Handling Costs are included in above prices
Payment Method by Bank Transfer or Postal Transfer

For Ordering or More Information:

ASC Co. (Analytical Solutions & Consulting Corp.)
B-1701, Samhomulsan Bldg. 275-6
Yangjae-Dong, Seocho-Ku
Seoul, Korea, 137-130

Phone : 02-589-2011 / 2 
Fax : 02-589-2010
E-Mail : ascco@nownuri.net

SmartDraw Information
Winner Best Business Program - Ziff Davis Awards (PC Magazine) 1996

Winner Best Graphics Program - SIA 1995



"..simple elegance..", "..a delight.." - PC Magazine July 1995

Order the SmartDraw 3.1 Combo Pack
SmartDraw 3.1 is available in both Windows 95 and Windows 3.1 Editions. When you order the 
SmartDraw COMBO PACK you automatically get BOTH versions of SmartDraw. This is ideal if 
you are still using Windows 3.1 but plan to upgrade to Windows 95 or NT 4.0 later. 

Order SmartDraw 3.1 and for just KRW 81000, here's what you get:
¨ Full versions of BOTH the Win 3.1 and Win 95 program with no time limit
¨ More than 1500 symbols and templates
¨ A 120 page printed and bound manual, with index and table of contents
¨ 90 days of paid support
¨ Notices of updates, and additional offers

If your time limit has expired! Place an order and we will reset your trial for 
another 30 days while you wait for delivery. 

SmartDraw Add-on Templates and Libraries
SmartDraw Flyers and Fun Collection
The SmartDraw Flyers and Fun Collection is a collection of more than 150 templates and clip-art images
designed for making one page flyers, posters, and signs. It has great-looking layouts for major holidays, 
celebrations and things you can use at the office. Kids will love it too. With the Flyers and Fun Collection 
you can use SmartDraw for all your drawing needs. The Flyers and Fun Collection is only KRW 
32,000 and REQUIRES SmartDraw.

SmartDraw Maps and International Collection
The Maps and International Collection is a collection of more than 500 symbols and templates covering 
maps of the USA and the whole world. It includes the countries of America, Asia, Africa and Europe and 
the flags of 136 countries. 
The maps of individual countries (and US States) fit together to form a complete map of their entire 
region. This means you can create you own regional maps, or you can use those already assembled as 
templates. 
US Templates include The US by region (North East, Mid-West, Pacific etc.), by congressional district, 
by zip code, and the counties of each state. World templates include major regions of the world, 
including SE Asia, Central Asia, Central Europe, Russia, Middle East etc. You can color and manipulate 
each of the countries, states or other components of these maps individually. The Maps and 
International Collection is only KRW 32,000 and REQUIRES SmartDraw.



Australian Order Form (Individual Use)    [Print this form using the Print 
Topic command]
To purchase a copy of SmartDraw 3.0, either:
+Mail this form and payment to: Dunson P/L, 30 Elliott Rd., Dandenong, Victoria, Australia 3175
+or, Fax the form, with credit card information filled in below, to (03) 9706 8704
+or, call Dunson P/L at (03) 9706 8773
Name_________________________________    Company______________________________
Street________________________________________________________________________    
City_________________________ State______ Code___________ Country_______________
Phone ____________________ Fax _____________________ EMail____________________
Prices good through 1998

Individual Use License
This is a license that permits the use of SmartDraw on a single computer, or on up to two computers used 
exclusively by the same individual user. It includes one copy of the program and its documentation.
SmartDraw 3 COMBO PACK…… Copies required _____ x $89.00……………… ______
(Includes both 16 bit Windows 3.1 and 32 bit Windows 95 versions of SmartDraw)

Add-on Templates and Libraries Ordered
SmartDraw Flyers and Fun Collection.. Copies required _____ x $35.00………

______
The SmartDraw Flyers and Fun Collection is a collection of more than 150 templates and clip-art images designed 
for making one page flyers, posters, and signs. It has great-looking layouts for celebrations and    the office. Kids 
will love it too.
Maps and International Collection.............. Copies required _____ x $35.00… ______
The Maps and International Collection is a collection of more than 500 symbols and templates covering maps of 
the USA and the whole world. It includes the countries of America, Asia, Africa and Europe and the flags of 136 
countries. 

Diskette Media
3.5 Diskettes: [Pricing above includes CD, add $10 per order for diskettes]             

Shipping and Handling (Aus $10, Non-Aus $15)                                               
______
Total and Payment Method (Call First for Purchase Orders.)
Credit Card:    __Bankcard        __Visa        __MasterCard 
Number: __ __ __ __    __ __ __ __    __ __ __ __    __ __ __ __      
Name:          __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __      
Expires    __ __    / __ __      Signature_______________________
Payment Method:    ___    Credit Card        ___ Check or Money Order

Total ($AUS)……… ______



Australian Order Form (Multiple Use Licenses)
To purchase a copy of SmartDraw    either:
+Mail this form and payment to: Dunson P/L, 30 Elliott Rd., Dandenong, Victoria, Australia 3175
+or, Fax the form, with credit card information filled in below, to (03) 9706 8704
+or, call Dunson P/L at (03) 9706 8773
Name_________________________________    Company______________________________
Street________________________________________________________________________    
City_________________________ State______ Code___________ Country_______________
Phone ____________________ Fax _____________________ EMail____________________
Prices good through December 1997

Multiple Use License
This is a license that permits the use of SmartDraw on a more than one computer used as the same site (a site 
license), or on the same network. It includes only one copy of the program and documentation.    You may buy any 
number of licenses (above 10) meet your needs. Call, if necessary, for more information.

Products Ordered (all licenses include 1 set of Manuals & CD ROM)
SmartDraw 3 (CD ROM) (Includes both Windows 3.1 and Windows 95 versions)

10-24 Computers ................. Quantity _____ x $79.00... ... ... ... ... ______
25-99 Computers ................. Quantity _____ x $65.00... ... ... ... ... ______
100+ Computers .................. Quantity _____ x $55.00... ... ... ... ... ______

Extra Manuals and Disks ......... Quantity _____ x      $10.00... ... ... ... ... ______

SmartDraw Flyers and Fun Collection
10-99 Computers ................. Quantity _____ x $30.00... ... ... ... ... ______
100+ Computers    ................. Quantity _____ x $25.00... ... ... ... ... ______

SmartDraw Maps and International Collection
10-99 Computers ................. Quantity _____ x $30.00... ... ... ... ... ______
100+ Computers    ................. Quantity _____ x $25.00... ... ... ... ... ______

Diskette Media
3.5 Diskettes: [Pricing above includes CD, add $10 per copy for diskettes]             

Total and Payment Method (Call First for Purchase Orders.)
Credit Card:    __Bankcard        __Visa        __MasterCard)                Shipping & Handling  ______
Number: __ __ __ __    __ __ __ __    __ __ __ __    __ __ __ __      (AUS=$10, Non-AUS=$15)
Name:          __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __      
Expires    __ __    / __ __      Signature_______________________
Payment Method:    ___    Credit Card        ___ Check or Money Order

Total ($AUS)……… ______

SmartDraw Ordering Information



Winner Best Business Program - Ziff Davis Awards (PC Magazine)
1996

Winner Best Graphics Program - SIA 1995
"..simple elegance..", "..a delight.." - PC Magazine July 1995

Order the SmartDraw 3 Combo Pack
SmartDraw 3 is available in both Windows 95 and Windows 3.1 Editions. When you order 
the SmartDraw COMBO PACK you automatically get BOTH versions of SmartDraw. 
This is ideal if you are still using Windows 3.1 but plan to upgrade to Windows 95 or NT 4.0 
later. Have your cake and eat it too!

Order SmartDraw 3 and for just $89.00, here's what you get:
¨ Full versions of BOTH the Win 3.1 and Win 95 program with no time limit
¨ More than 1000 additional symbols
¨ A 120 page printed and bound manual, with index and table of contents
¨ 90 days of paid support
¨ Notices of updates, and additional offers

If your time limit has expired! Place an order and we will reset your
trial for another 30 days while you wait for delivery. 

SmartDraw Add-on Templates and Libraries
SmartDraw Flyers and Fun Collection
The SmartDraw Flyers and Fun Collection is a collection of more than 150 templates and 
clip-art images designed for making one page flyers, posters, and signs. It has great-
looking layouts for major holidays, celebrations and things you can use at the office. Kids 
will love it too. With the Flyers and Fun Collection you can use SmartDraw for all your 
drawing needs. The Flyers and Fun Collection is only $35 and REQUIRES 
SmartDraw 3

SmartDraw Maps and International Collection
The Maps and International Collection is a collection of more than 500 symbols and 
templates covering maps of the USA and the whole world. It includes the countries of 
America, Asia, Africa and Europe and the flags of 136 countries. 
The maps of individual countries (and US States) fit together to form a complete map of 
their entire region. This means you can create you own regional maps, or you can use 
those already assembled as templates. 
US Templates include The US by region (North East, Mid-West, Pacific etc.), by 
congressional district, by zip code, and the counties of each state. World templates include 
major regions of the world, including SE Asia, Central Asia, Central Europe, Russia, Middle 
East etc. You can color and manipulate each of the countries, states or other components of
these maps individually. The Maps and International Collection is only $35 and 
REQUIRES SmartDraw 3




